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INTRODUCTION

+ CAD /CAM stands for Computer Aided Design and Computer Aided Manufacturing.
It is the technology concerned with the use of computers to perform design and
manufacturing functions.

+ CAD can be defined as the use of computers systems to aid in the creation,
modification, analysis, or optimization of a design.

« CAM is the use of computer systems to plan, manage and control the operations of
manufacturing plant through either direct or indirect computer interface with the
plant’s production resources.

CAD software is used to increase the productivity of the designer, improve the quality of
design, improve communications through documentation, and to create a database for
manufacturing. CAD output is often in the form of electronic files for print, machining, or
other manufacturing operations.

CAD (computer-aided design) software is used by architects, engineers, drafters, artists,
and others to create precision drawings or technical illustrations. CAD software can be used
to create two-dimensional (2-D) drawings or three-dimensional (3-D) models.

CAD is an important industrial art extensively used in many applications, including
automotive, shipbuilding, and aerospace industries, industrial and architectural design,
prosthetics, and many more

Computer Aided Drafting is a process of preparing a drawing of an object on the screen
of a computer. There are various types of drawings in different fields of engineering and
sciences. In the fields of mechanical or aeronautical engineering, the drawings of machine
components and the layouts of them are prepared. In the field of civil engineering, plans and
layouts of the buildings are prepared. In the field of electrical engineering, the layouts of
power distribution system are prepared. In all fields of engineering use of computer is made
for drawing and drafting.

BENEFITS OF CAD:
The implementation of the CAD system provides variety of benefits to the industries
in design and production as given below:
1. Increases Productivity
. Easier to Read
. Higher Quality Designs
. Customer modifications in drawing are easier
. Reuse and Easily Change Designs
. Improved accuracy of drawing
. Simplified Sharing
. Colours can be used to customize the product
. Production of orthographic projections with dimensions and tolerances
10. Documenting the Design
11. Preparation of assembly or sub assembly drawings
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12. Preparation of part list
13. Machining and tolerance symbols at the required surfaces
14. Printing can be done to any scale

Computer-aided design (CAD) is software that product developers use to create
digital 2D drawings and 3D models. These designs are typically used to show objects that
will later be manufactured and delivered to customers.

CAD SOFTWARES

. AUTOCAD

. PTC CREO (Pro/ENGINEER)

CATIA

. NX (UG NX OR UNIGRAPHICS)5. PAINT
. On shape

. Autodesk INVENTOR

. SOLID WORKS

. HYPERMESH

. Autodesk Fusion 360
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INTRODUCTION TO PTC CREO

PTC (Parametric Technology Corporation) is a computer software and services company
founded in 1985 and headquartered in Boston, Massachusetts. The company began initially
developing parametric, associative feature-based, solid computer-aided design (CAD)
modeling software in 1988, including an Internet-based product for product
lifecycle management (PLM) in 1998.

CREO(Formerly known as Pro/ENGINEER) is a product design software created by
PTC for 2D/3D CAD, parametric, direct modelling. It also features simulation tools for
analyzing the product’s performance including structural, vibration, and thermal analysis.

Creo is a powerful, integrated family of product design software. It’s used by
thousands of leading manufacturers across the globe. It is a PTC product — the originators of
parametric CAD technology. The way Creo works is that it is made up of individual apps,
including:

[1 Creo Parametric

1 Creo Simulate

1 Creo Direct

[J Creo Layout

(1 Creo Options Modeler

Each Creo app serves a different purpose in the product development process. This
means that Creo takes you through every stage, including concept design work, design and
analysis. Then it also enables you to communicate effectively with downstream partners, for
instance manufacturing and technical publications.

Creo Parametric is the essential tool for 3D CAD. It is state-of-the-art software, which
promotes best practices in design and maintains your industry standards. Answer your
pressing design challenges with Creo Parametric, with its fully-fledged powerful yet flexible
3D CAD abilities. Use it to accommodate multi-CAD data, electromechanical design and
make alterations late in the design process.

The PTC Creo suite includes product design and engineering software solutions. Creo
runs on Microsoft Windows and provides apps for 3D CAD parametric feature solid
modeling, 3D direct modeling, 2D orthographic views, Finite Element Analysis and
simulation, schematic design, technical illustrations, and viewing and visualization.

Creo is a family or suite of Computer-aided design (CAD) apps supporting product
design for discrete manufacturers and is developed by PTC. The suite consists of apps, each
delivering a distinct set of capabilities for a user role within product development.
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Creo runs on Microsoft Windows and provides apps for 3D CAD parametric
featuresolid modeling, 3D direct modeling, 2D orthographic views, Finite Element Analysis
and simulation, schematic design, technical illustrations, and viewing and visualization.

Release history
Version Release date
Creo 1.0 | 6 January 2011
Creo 2.0 | 27 March 2012
Creo 3.0 | 17 March 2014
Creo 4.0 | 15 December 2016 [
Creo 5.0 | 19 March 2018 [®
Creo 6.0 | 19 March 2019

Protrusion features:
Protrusion is the method of adding a solid material of the method. Pro-E provides the
following basic methods of adding material to a method.

» Extrude: creates a solid feature by extruding a section named to the section.
> Revolve: creates a solid surface by revolving a section about an axis.

» Sweep: creates a solid feature by sweeping a section about a path.
>

Blend: creates a solid feature by blending various cross sections at various
levels.

[CAD/CAM MANUAL]


https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/Solid_modeling#Parametric_and_feature-based_modeling
https://en.wikipedia.org/wiki/Solid_modeling#Parametric_and_feature-based_modeling
https://en.wikipedia.org/wiki/Solid_modeling
https://en.wikipedia.org/wiki/Orthographic_projection_(geometry)
https://en.wikipedia.org/wiki/Schematic_capture
https://en.wikipedia.org/wiki/Technical_illustration
https://en.wikipedia.org/wiki/Product_visualization#Product_visualization

MREC (A) Mechanical

PTC Creo Parametric 3.0 Interface

[

View Options

Ribbon Menu

Origin (Axis Center x-0, y-0, z-0)

y

Feature Manager

Mouse Buttons

Left Button - Most commonly used for selecting objects on the screen or sketching.

Right Button — Used for activating pop-up menu items, typically used when editing.
(Note: you must hold the down button for 2 seconds)

Center Button — (option) Used for model rotation, dimensioning, zoom when holding
Ctrl key, and pan when holding Shift key. It also cancels commands and line chains.

Center Scroll Wheel — (option) same as Center Button when depressed, only it
activates Zoom feature when scrolling wheel.
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View options:

Default Orentation
BACK

BOTTOM

FRONT

LEFT
RIGHT
TOP

4 | (1]

F

& x|
« 3 Point
Start Sketch « Tangent
Concentric
Datum Plane

Obiects Spin Center
ARE [ X
¥, @ 7 & g
1 ]
e o Create Cross-sections
| | for a drawing
|
v / /
0 View ==
Smp Reo  Neec | Ceert | &
| Mew Edt ~ Diapicry =
Mamee
. M
Symbeoic Aep
Geamesy Aep
Graphics Aep
Properies 55 Chase
Sketching
Constraint/ .
Relations | Trim | Apply/Finish
) Mirror |

Dim

Convert
Entities &
Offset

Q0 %k

NOTE: If you do not see all of these icons on your interface you can customize the toolbars to bring

them up. Right mouse button click on the top grey frame of the window and locate the “customize” option.

There are 3 primary file types in Creo, which include...

1. Part (.prt) Single part or volume.

2. Assembly (.asm) Multiple parts in one file assembled.
3. Drawing (.drw) The 2D layout containing views, dimensions, and annotations.
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List of Experiments

CAD/CAM Lab
List of Experiment

I. CAD

1. Generation of 3D Model through Extrude Feature.

2. Generation of 3D Model through Extrude, Round & Mirror Features.

3. Generation of 3D Model through Extrude, Hole, Pattern &Rib
Features.

4. Generation of 3D Model through Revolve Feature.

5. Feature based and Boolean based 3D Modeling.

6. Modeling and Assembly of Flange Coupling.

II. CAM

7. Step Turning operation using CNC Lathe Machine.

8. Multiple Turning operation using CNC Lathe Machine.
9. Thread cutting operation using CNC Lathe Machine.
10. Drilling Cycle using CNC Milling Machine.

11. Contour Cycle using CNC Milling Machine.

12. Pocketing Cycle using CNC Milling Machine.
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EXERCISE:1 3D Part Modeling — 1

AlM:
To model the given object by using the Extrude features as per the given dimensions.

Software required: PTC Creo Parametric 3.0

Commands used:
2D Commands: line, circle , arc, trim,
3D Commands: Extrude,Mirror, Round

Description of Extrusion Feature:

An extrude feature is based on a two-dimensional sketch. It linearly extrudes a sketch
perpendicular to the sketching plane to create or remove material. You can either select the
sketch first or then start the Extrude tool, or you can start the Extrude tool and then select the
sketch.

Depth Remove

Surface Value material tool

I

| Ak v v A 7] [ |22 v %

Plakement Options Ploperties

Extrude Thicken

Solid depth Invert Tool &

ool tool value

Solid: This option is selected by default to make solid extrude.

Surface: This can be used to extrude the sketch as surface.

Extrude depth tool: is used to control extrude by specifying some constraints.

Depth value: used to specify the dimension of depth. Some extrude types do not need
this.

Invert tool: used to change the direction of extrude opposite to the reference direction.
Remove material: this tool is used to remove the material while extruding.

Thicken tool: is used to extrude as thick sheet. Thickness value can be adjust by
entering the value in box (just right to the thicken tool). The invert tool next to the
thicken tool is used to specify the direction of thickness by three ways.

YVVV VVVYVY
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PROCEDURE:
STEP 1. Open PTC Creo Parametric 3.0 by either using the desktop icon or using the
program menu

PTC Creo
Parametr...

STEP 2. Next select New From Menu bar, make sure the type is set to part and sub type as a
Solid. Change the name to whatever you want to name your part and Click OK and also
select Template as mmns_part_solid and Click on ok

New x
Type Sub-type Hewr File Options »
= Layout ® Solid Template
7 Sketch Sheetmetal .
mmns_part_solid Browse...
@ (] Part Bulk
| Assembly Empty ~
. inlb=_harn_part
14, Wanufacturin il P
e . < inlb=_part_escad
_FT-.::] Drawing inlbs_part_solid
___j Format mmns_harn_part
J Report mmns_part_solid -
- Diagram
i0|  Motebook Parameters
— '
4 MWarkup MODELED_BY
; DESCRIPTION
' Name: | prt0002
Commaon name:
Use default template
Copy associated drawings
OK Cancel

OK Cancel

STEP 3.Your screen should now look like this.
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PRTO0003 (Active) - PTC Creo Parametric Educational Edition

Applications

Filev | Model | Analysis Annotate Render Tools View Flexible Modeling
g e 7 Axs A @ oo Revowe £ Project
Gl I+ copy G <*

- Copy Geometry ¥ point v
Regenerate Flane Sketch  Extrude Pattern
- %! shrinkwrap 3%x Coordinate System £ -
Editing ~

Operations ~ GetData ~ Datum ~ Shapes ~ Engineering

e d
k= e

ModeiTree Tl ~

ol I TR

Qw4

R

(9 FRTO003 PRT
7 RIGHT
7 Top
L7 FRONT
X8 pRT_csvs_DEF
= Insert Here

;épﬁr,csvs, F

E

= Using C:\Program Files\FTC\Creo 3.0\M030\Common Files\templatesimmns_part_solid.prt as the tempiate.

= B R
~pO-@
2y D
! ] Style
Boundary Component
Blend ()] Freestyle  interface
Surfaces ~ Model Intent ~
Smart -

STEP 4. Next select the required Sketch plane (Top)
Select Sketch from tool bar and select Sketch View option

PRT0003 {Active) - PTC Creo Parametric Educational Edition

File v Model Analysis Annotate Render Tools View Flexible Modeling Applications Skerch
g ¥ b i Centerine A Line = Tiac - N_Filt ~ D offset | Centerine ~ > - S e g
: (%)
] » X Point [Zi Rectangle ~ ) Elipse = |7~ Chamfer v | Thicken < Point = - N =
N File Select Construction | R Palette
@ | System - J+ coordinate System Mode Gjcicle ~ AU Spine LA Text -+ Coordinate System £ L=y
Setup v | GetData | Operations + Datum Sketching Edting ~ Constrain ~
v om ¥

=

Er
] E3]

Q| ® Q[ SEIEGERYEES

Model Tree TJ = R
(P PRTO003.PRT

L RiGHT

O 1op

L7 FRONT

K= PRT_C5vs_DEF

* Insert Here

w8 sheteh 1
| PRT_CSYS_DEF

= B %

PS-0

1 ;

) = L

[ - v X

Normal . Feature - OK Cancel
fketl  Reguirements i

Dimension Inspect v Close

® Section has been reoriented to 2D orientation.

Step 5: Sketch a 2Dprofile of the model as shown in Figure.l as per the dimensions

and Click on ok
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E n
H T
16.00
H
500~ o 0o }
) —a - ]
|
: 1
bt
™ =2 00
9500
PRT CE¥s DEF H
- Qi: e ——
I

Figure.1

Step6: Extrude the sketch perpendicular to sketch plane. And Specify width and direction
of an Extrusion and Click on ok.

z o EE R S PRT0002 (Active) - PTC Creo Parametric Educational Edition = & =
Filew | | Model Analysis Annotate  Render Tools View Flexible Modeling  Applications Extrude ~PB-@
&)
= \
] dk - |[eo0  [~104 [ Il [OEE[f 60 o x oo
Applies and saves any changes you have made in th .
e — || s | e feature tool and then closes the tool dashboard
[ =
]3] L
ModelTree  Th - [ - T
P PRTOO002 PRT
L7 RIGHT
L7 ToP
L7 FRONT
¥ PRT_cvs_DEF
5 Sketen 1
® Insert Here
> (Fextrude 1
gl @ My | 1seectea Sketch -

Step7: Select Extrude — Required surface — Sketch View option —»
Specify references —» Draw the required sketch as shown in Figure.2 Click on ok
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Lulu}

L=

Figure.2

== s R L R = PRTO0002 (Active) - PTC Creo Parametric Educational Edition = EP
PN -
File~ | | Model Analysis Annotate Render Tools View Flexible Modeling  Applications Sketch pPO-0
5 < % I Cnterine W Line ~ “jare~ N_Filet ~ |0 Offsst | Centerine ~ \& =5t L e Ramd (=1 ' v X
in] = Point I—i Rectangle ~ O Elipse v {7 Chamfer = | Thicken Point i - N = b
=l . i - Y i}
" File Select Construction | i ’ Normal Feature OK  Cancel
=l System || - Js Coordinate System Mode GJ circle ~ U spine A Text O Project Coordinate System 2@ L g k8 Requirements | 8
Setup ~ GetData Operations ~ Datum Shetching Ediing | Constrain~ | Dimension ~ Inspect ~ Close
7
Q& & |4 0, EAEEEAE R
ModelTree T - 5] -~ ‘e
[ prRTO0DZ PRT 20
O RiGHT
O op i i
L7 FRONT
X PRT_csY'S_DEF 200
S v
(P Extruge 1
+ insert Here .
8| [@@| = wnen a constraint is active, right ciick to cycle through lockidisable/eggble the constraint. Use Tab key to toggle active constraint. Press and hokd Shiftto disable Snapping to new ¢ gy 1selected Al -

T )

GRECEE =R 2=k 4 PRT0002 (Active) - PTC Creo Parametric Educational Edition = B =
Filex | Model Analysis Annotate Render Tools View Flexible Modeling  Applications Extrude L©-0
(@ |4k ~|[1200 A AT Il [ v x Datum
Placement | Options | Properties
e A==
¥ . =| K, o
o alalalaJ AREIS
modeiree Tl ~ 2] ~ 5y
(J PRT000Z.PRT
L RigHT
3 ToP
L7 FRONT
%X PRT_CSVS_DEF
> (" exruge 1
X Sketch 2
F insert Here
b (Prexdrude 2
|8o| @@ oseiecta sketon i an imternal sketch is preferred, the "EGI” option can be found i the Placement panel) #) | 1sectes Sketch -
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Step9: Select the datum plane at the middle of the sketch and select the part which is to be
duplicated then select the mirror and then select the plane to complete the object Click on ok

BE=3" ] 2 39 - ® - PRT0002 (Active) - PTC Creo Parametric Educational Edition = @ ¢
Ps <
File~ | | Model | Analysis Annotate Render Tools View Flexible Modeling  Applications 0e-0
PR : } User- 4 i £ o Z I
it o =} User-Defined Feature. U J Axis La% i@ 5o Revove il Hole ) Draft : { [ Fan o
&l 15} Copy Geometry % Point + {3 sweep ~ ¥Round ~  m) Shel 2 style
Regenerate Plane Sketch  Extrude Component
- Dele B shrinkwrap 3+ Coordinate System # SweptBlend 3 Chamfer v 5l Rib v Blend [CJ) Freestyle Interface
Operations ~ Get Data ~ Datum ~ Shapes ~ Engineering ~ Editing ~ Surfaces Model Intent =
o al& e T=EIEAGE =
A S N - A e

ModetTree T - =] + a
(P paTO00Z PRT
£7 RIGHT
I Top
£7 FRONT
54+ pRT_CSY'S_DEF

> (A edrude 1

b P Extruge 2
£7 pTid

¥ D Mirror 1
» Pextrude 2 (2)
P Insert Here

Step10: Round the edges of a part to a specified radius by using Round Command Click
on ok

RESULT:

Thus the given model is done by using PTC Creo Parametric 3.0
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EXERCISE:2 3D Part Modeling — 2

AlM:

To model the given object by using the PTC Creo Parametric 3.0 as per the given
dimensions.
Software required:PTC Creo Parametric 3.0

Commands used:
2D Commands: line, circle ,arc, trim
3D Commands: Extrude, Hole, Rib

Description of Extrusion Feature:

An extrude feature is based on a two-dimensional sketch. It linearly extrudes a sketch
perpendicular to the sketching plane to create or remove material. You can either select the
sketch first or then start the Extrude tool, or you can start the Extrude tool and then select the
sketch.

Depth Remove

Surface Value material tool

[

3| |4k ~i|19831 vi % B |[C|212 v| %

Plagement Options Pjloperties

e Thicken

Solid depth Invert Tool &

tool tool value

Solid: This option is selected by default to make solid extrude.

Surface: This can be used to extrude the sketch as surface.

Extrude depth tool: is used to control extrude by specifying some constraints.
Depth value: used to specify the dimension of depth. Some extrude types do not need
this.

Invert tool: used to change the direction of extrude opposite to the reference
direction.

Remove material: this tool is used to remove the material while extruding.

Thicken tool: is used to extrude as thick sheet. Thickness value can be adjust by
entering the value in box (just right to the thicken tool). The invert tool next to the
thicken tool is used to specify the direction of thickness by three ways.

Rib:

A rib is a special type of protrusion designed to create a thin wall or web to support two
surface.

VV V VVVYVY
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PROCEDURE:
STEP 1. . Open PTC Creo Parametric 3.0 by either using the desktop icon or using the
program menu

PTC Creo
Parametr...

STEP 2. Next select New From Menu bar, make sure the type is set to part and sub type as a
Solid. Change the name to whatever you want to name your part and Click OK And also
select Template as mmns_part_solid and Click on ok

New x
New File Options x
Type Sub-type
Template
= Layout @ Solid .
mmns_part_solid Browse...
L Sketch Sheetmetal
® [J Part Bulk Empty -
J Assembly inlbs_harn_part
i d
LJ‘, Manufacturing !"":E—pﬁrt—e':ﬁ_“
=] Drawi inlbs_part_solid
—:J rawing mmns_harn_part
:_.uj Format mmns_part_solid -~
J Report
TE Diagram Parameters
io] Notebook
| ﬁ Markup MODELED_BY
1 DESCRIPTION
!
| Name: | prid003
Commen name:
Use default template
Copy associated drawings
0K Cancel oK Cancel
PRT0003 (Active) - PTC Creo Parametric Educational Edition - @ =
File~ | | Model | Analysis Annotate Render Tools View Flexible Modeling  Applications ~PO-0
U ? User-Defined Feature J axis o Project <y O 3)
o s [T ¢ = 7~ N
&l 15 Copy Geometry I Point ~ J ] Styie —4
Regenerat Pla Patt Boundary Component
A Shrinkwrap 2%x Coordinate System Bleng Freestyle  Intert
Operations + Get Data ~ Datum ~ Shapes ~ Engineering Editing = Surfaces Mode Intent ~
Lhed 2 59 v o= -
bl Ll 3] a| @ |a |3 0 @ & ][
ModeiTree  T| ~ 5] ~ ‘w
(@ paT0003 PAT
L7 RIGHT
7 Top
£7 FRONT
$K¥PRT_CSVS_DEF
+ nsert Here
;@T,csvs, F
E:
§o| @@ | = Using C\Program Fies\PTCCren 3.0W1030\Common Fies\tempiates\mmns._part_sold.prt as the template n Smart

1:54 PM

SR =L v
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STEP 4. Next select the required Sketch plane (Front)
Select Sketch from tool bar and select Sketch View option

PRT0003 (Active) - PTC Creo Pa

Step 5: Select line command and Draw the required Sketch and Edit the Dimensions
as shown in Figure.1 and Click on ok

IFLLARIE]
H
T
-
I
150 - £ L
i H ”
_BLPRT cavs DEF ) 5.0
i - ot 30 i
Figure.l

Step6: Extrude the sketch perpendicular to sketch plane. and Specify width and direction
of an Extrusion and Click on ok
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(] 3 “ ] - PRT0002 (Active) - PTC Creo Parametric Educational Edition - @ B

(] dk[-|[rss0  |+54 [ T 4 I (@ i@Fdod |« x

Step7: Using the Hole Tool
e Select Hole from the Engineering group.
e Specify the hole type as Simple.
e Select the surface to place the hole on and edit the hole diameter.
e Specify the hole depth.
e Add offset references using the dashboard or drag handles in the graphics window.
e Click Complete Feature from the dashboard.

Step8: Create the datum plane at the distance 40 mm from one end of the surface along the
length of the sketch and with this as a reference plane draw the required shape of the object
and Click on ok

Step9: Select Extrude — select plane (Created Datum plane) —> Sketch View option
Specify references — Draw the required sketch as shown in Figure.2 — Click on ok

[CAD/CAM MANUAL]



MREC (A)

Mechanical

S0 00

Figure.2

PRT0002 (Active) - PTC Crec Parametric Educational Edition

>
Palette

-+ Coordinate System

=g

Hwo
Model

: 4

Analysis Annotate Render Tools View Flexible Modeling Applications Skerch

Select

File ~

a2

=

[ A Line = “are v N\ _Filet v |0 ofiset | Centerine -

Centerine
"1 Rectangle ~ ) Elipse ~ |7 Chamfer + | Thicken 3 Point

A Text

Sketching

Foint
Construction

Wode

File

&2 System J Coordinate System Gj circle ~ " Sping (I Project
Setup ~ | GetData Operations ~ Datum

;::IE

s

a o o @ 9 1
o |3 @ Q| ),
ModerTree | v [ v 4
(9 pRTO00Z.PRT 00~
£ miGHT
L Top
£ FRONT

3x pRT_CSYS_DEF

00—t

# Extrude 1

# extrute 2
O o
* Insert Here
X S sketch 3

= @ =

o©-0

=58 + @ [ = "
L

Feature
Requirements | 5

— v X

oK

Normal
e

S N
=7

Constrain =

= Cancel
&

£
Editing Dimension ~ Inspect Close

t [55[a]

1
60.00

[5e| @ o select or drag over entiies to trim

1]

Step9: Extrude the sketch by using Symmetry option and specify the

extrusion and Click on ok

width and direction of
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] i

PRTO0002 (Active) - PTC Creo Parametric Educational Edition = B =X

~pO-@
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude

N
@ |dk|~|[s000 A AT Il ©if[fded |« x Datum

Applies and saves any changes you have made in the

Placement | Options | Properties feature tool and then closes the taol dashboard

|6 Q&la@nn&E kieEE
ModelTree  T| ~ [ + 'a
(3 pRTO00Z PRT
£ picHT
L Top
L7 FRONT
3 pRT_CSYS_DEF

» (P Extrude 1

» (P Extrude 2
L ot
iketch 3/
*F Insert Here
v (Pabdrude 3
A zesketon 2

#) | 1 sclected Sketch -

. | 1214PM
AR, B

Step 10: Create an datum plane at specified distance and select Rib Command from Model
Step 11: Specify width of Rib to be Extruded and Click on ok

Step 12: Thus the model is created by using Rib Command

A=) L= ROl PRT0002 (Active) - PTC Creo Parametric Educational Edition = B =

& -
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude 0 e o

= = N
Ola [Blrhe 4 78 C Il ®F[F 60 o x .

Applies and saves any changes you have mads in the .
Placement | Options | Properties feature tool and then closes the tool dashboard

FlaE
modeiree Tl ~ 2] ~ 5y
(P PRT000Z.PRT
L RigHT
3 ToP
L7 FRONT
%X PRT_CSVS_DEF

» f Extrude 1

> (P ednge2
L7 pTut

b (P Extrude 3
L pimz
1 Sketch 4
¥ Insert Here
» (Priedrude 4

By | 1 selectea Sketch ~

RESULT:

Thus the given model is created by using PTC Creo Parametric 3.0
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EXERCISE:3 3D Part Modeling — 3

AlM:

To model the given object by using the PTC Creo Parametric 3.0 as per the given
dimensions.
Software required:PTC Creo Parametric 3.0

Commands used:
2D Commands: line, circle ,arc, trim
3D Commands: Extrude, Hole, Rib

Description of Extrusion Feature:

An extrude feature is based on a two-dimensional sketch. It linearly extrudes a sketch
perpendicular to the sketching plane to create or remove material. You can either select the
sketch first or then start the Extrude tool, or you can start the Extrude tool and then select the
sketch.

Depth Remove

Surface Value material tool

[

3| |4k ~i|19831 vi % B |[C|212 v| %

Plagement Options Pjloperties

e Thicken

Solid depth Invert Tool &

tool tool value

Solid: This option is selected by default to make solid extrude.

Surface: This can be used to extrude the sketch as surface.

Extrude depth tool: is used to control extrude by specifying some constraints.
Depth value: used to specify the dimension of depth. Some extrude types do not need
this.

Invert tool: used to change the direction of extrude opposite to the reference
direction.

Remove material: this tool is used to remove the material while extruding.

Thicken tool: is used to extrude as thick sheet. Thickness value can be adjust by
entering the value in box (just right to the thicken tool). The invert tool next to the
thicken tool is used to specify the direction of thickness by three ways.

VV V VVVYVY
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PROCEDURE:
STEP 1. . Open PTC Creo Parametric 3.0 by either using the desktop icon or using the
program menu

PTC Creo
Parametr...

STEP 2. Next select New From Menu bar, make sure the type is set to part and sub type as a
Solid. Change the name to whatever you want to name your part and Click OK And also
select Template as mmns_part_solid and Click on ok

New x
Newr File Options »
Type Sub-type
Template

= Layout @ Solid

mmns_part_solid Browse...

L Sketch Sheetmetal

@ [ Part Bulk Empty -
J Assembly inlbs_harn_part

T . inle=_part_ecad

[i¥, Manufacturing . X

=] D . inlb=_part_=solid

—:J rawing mmns_harn_part

:_.uj Format mmns_part_solid -

J Report

TE Diagram Parameters

io] Notebook
| ﬁ Markup MODELED_B™
1 DESCRIPTION
|
! Name: | prid003

Commen name:
Use default template
Copy associated drawings
0K Cancel

OK Cancel

STEP 3.Your screen should now look like this.
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PRT0003 (Active) - PTC Creo Parametric Educational Edition - B =

P S-0

Filew | | Model | Analysis Annotate Render Tools \View Flexible Modeling  Applications
jt‘ 2 User-Defined Feature D S Axis “ A o Revolve 5 Project -‘4’./ O Fin ;.7
I4 Copy Geometry < Point ~ e ! ] Style
Regenerate Flane Sketch  Extrude Pattern Boundary Component
= 1 Shrinkwrap 4 Coordinate System # Swept Blend - Blend [ Freestyle Interface
Operations. ~ Get Data ~ Datum ~ Shapes ~ Engineering ~ Editing ~ Surfaces ~ Model Intent ~
D 2 EF o= A v
o ® | @ i G
Ba > T % -
EE=1]E] AR (2, B | B 2
Model Tree I RAE R
(3 PRT0003 PRT
7 riGHT
7 ToP
£7 FRONT
3K+ PRT_CSYS_DEF
¥ Insert Here

o 4»: RT_czvs _CEF

B

a| §®  * Using C:\Program Files\PTC\Creo 3.0\MI030\Common FilesMemplates\mmns_part_solid.prt as the template

STEP 4. Next select the required Sketch plane (Front)
Select Sketch from tool bar and select Sketch View option

PRT0003 (Active) - PTC Creo Parametric Educational Edition

Filc~ | [ Model  Analysis  Annotate  Render  Tools  View  Flexible Modeling  Applications | | Sezch oe-0
| Centerine " A Line - T3 are v N_Filet - O Ofrser enterine ~ = e [=H

= rs 5 | Centeri L 3 _ Fitet LE Offset Centers O F ¥ +9 - B OB x
o > Point [Tf Rectangle ~ () Elipse ~ }/~ Chamfer ~ [L¥ Thicken < Point . N — "

" Fie Select con - - Palette Normal ~—  Feature oK cancel
&2 System = L Coordinate System X G circle ~ AU Spine IA Text s Coordinate System ] 4 {2  Requirements | i3t
Setup ~ | GetData Operations ~ Datum Sketching Edting | Constrain~ | Dimension ~ Inspect - Close

= T - = -
2 NE A3
. x| @@ | [T ][e

8o |2 g A | R ||| O, CA| | . >

Model Tree |~ 3 - B

O privous.er
T micHT

PET_CSVS_DEF

ction has been reoriented to 2D orientation.

Step 5: Select line command and Draw the required Sketch and Edit the Dimensions
as shown in Figure.1 and Click on ok
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ﬂj s} E= R PRT0001 (Active) - PTC Creo Parametric Educational Edition = B X
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Skerch D 9 T e
=g £ b | Centerine [ W Line v TjAarc v N_Filet v | Offset | Centerine ~ N P e ‘Hl [ 1] v X
3 it N2 L.
o} » 3 Point - [Tf Rectangle ~ ) Elipse * |/~ Chamfer ~ | Thicken < Point 2 4 N = ek e
File Select Construction - Palette Normal —  Featre - OK Cancel
@l system - Jo Coordinate System Mode G circle = ~y Spine JA Text T+ Coordinate System £ L -4 it Requirements | 3E
Selup ~ GetData Operafions ~ Datum Sketching Ediing | Constrain~  Dimension + Inspect = Close
o ONES y | iy | gl e ]
2y E AR b N
) | ® |||, (& & x| & b |55
ModeiTree Tl « [ » i
(P pRTO0N.PRT
L7 RIGHT
£7 Top
L7 FRONT =
3K+ PRI_CSYS_DEF
# Insert Here
X 52 Sketch 1
—efv
50.00
ol 13318
[12.00
7500
n H FRT_CSVE_DEF
S

&y 1 selected Al

gul |§® @ Section has been reoriented to 2D orientation

Step6: Extrude the sketch perpendicular to sketch plane. and Specify width and direction
of an Extrusion and Click on ok

Do~ e B x| PRTO0001 (Active) - PTC Creo Parametric Educational Edition = B %
o -
File ~ Model | Analysis Annotate Render Tools View  Flexible Modeling  Applications Le-0
3e 2} User-Defined Feature /s d o )l Hole ) Drat -  Project A~y O
& +]- Copy Geometry X% Point + JRound ~ ] Shel ' stk
Regenerate Plane Skefch  Extrude Pattern Boundary _ Component
- B Shrinkwrap ¥ Coordinate System 3 Chamfer ~ 5 Rib ~ - Blend [ Freestyle  Interface
Operations ~ Get Data ~ Datum~ Engineering + Edting ~ Surfaces ~ Model Intent ~
o . * | (= ] L | %y [C2[| S
B B & Al & Q|4 (1|2 |8 e
ModelTree T v i ~ T
(3 pRTO001.PRT
L7 RIGHT
£ Top
£7 FRONT

SX* PRT_CSYS_DEF

» (# extruge 1
# Insert Here

E., (ﬁ = Indicate two locations to define a box for the zoom area
14:01

Nl g B

Step7: Using the Material remove Tool
e Select shape from the Engineering group.
e Select the surface to place the shape on and edit the sahpe dimensions.
e Specify the shape depth.
e Add offset references using the dashboard or drag handles in the graphics window.

e Click Complete Feature from the dashboard.
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(2] *HYxm v PRT0001 {Active) - PTC Creo Parametric Educational Edition = B X
“p0-@
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude
e — 2385
& db-[s0 [ A C 4 I e@FE 6 |+ x .
Placement | Options | Properties
B " al& | & NEIEA =
[l ] A% |Q |4 04 @ T E e
ModeiTree Tl « [ » i
(P pRTO0N.PRT
7 piGHT
L7 ToP
LT FRONT
3 BRT_CSY'S_DEF
» [ extrude 1
% Sketch 2
* Insert Here
»
§a| @@ Selecta sketch (Ifan intsrnal sketch i preferred, the "EGi” option can be found in the Placement panel) ) | 1 selected Sketch -

(2] CHrw| PRTO0001 (Active) - PTC Creo Parametric Educational Edition

= B R
a -
File = Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude 0 e e
— N
0 dkl~[me %4 H T 1l [O|E[f 60 | x Datum
Placement | Options | Properties
g - -~ al @ & 1 1| %, 3z
g 3 & q & |d 0@ = ¥%|E e
ModelTree T v i~ T
(3 pRTO001.PRT
L7 RIGHT
£ ToP
£7 FRONT
SXx PRT_CSYS_DEF
» (P extrude 1
» (P Extrude 2
% Sketch 3
# Insert Here
>
PRT_CSVS_DEF
[8a| @@ o seiecta sketcn. (1f an internal sketch is preferred, the “Egi” option can be found in the Placement panel) By | 1 seectea Sketch ~
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(2] BHrx v PRT0001 {Active) - PTC Creo Parametric Educational Edition

File~ | Model Analysis Annotate Render Tools View  Flexible Modeling  Applications Extrude

Ola E-ze % [Aa C“% I ©iFE 60 v x

Placement | Options | Properties

El ¥
go ey | (4]
ModeiTree Tl « [ » i

(P pRTO0N.PRT

7 piGHT

L7 ToP

LT FRONT

.

3K PRT_CSYS_DEF

» [ extrude 1

» (B Extrude 2
N Sketch 3
* Insert Here

» (B redruce 3

= B X

“pe-@

Datum

ERT_CSVS_DEF

&y | 1 sclected Sketch v

Step8: Extrude the sketch by using Symmetry option and specify the width and direction of

extrusion and Click on ok

[2) BHre~ PRT0001 {Active) - PTC Creo Parametric Educational Edition

File ~ Model  Analysis  Annotate Render Tools View  Flexible Modeling  Applications Extrude

0 Bi-=0 4 7 C Il [QK[f 68 o x

Placement | Options | Properties

B 1
Ell R=]jE]
ModelTree T v i ~ T

(3 pRTO001.PRT

L7 RIGHT

L op

£7 FRONT

SXx PRT_CSYS_DEF

q & |G 2

» (# extruge 1

» (P Extrude 2

v

A extrude 3
=4
X Sketch 4
# Insert Here
b (B ebxtrude 4

= B X
“pe-@
=
\ %}
Datum

By | 1 sslected

Sketch -

RESULT:

Thus the given model is created by using PTC Creo Parametric 3.0
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EXERCISE:4 3D Part Modeling — 4

AlIM:

To model the given object using the extrude feature as per the given dimensions.

PROCEDURE:

Stepl:

Double click on creo parametric and then open new file

Bil=E-RdR4 PTC Creo Parametric Educational Edition = B o®
a -
File v Home ol =] (2]
- |
v =] & 4
New | Open t SelectWorking Erase Mot Model System Play
Directory  Displayed | Display Colors  Trail File
Data Settings ¥ % Utiities ~
s | 3]
Common Folders &5 | ntpiipte partcommunty.com Type Sub-type *
1 In Session % PARTcommunity 3D CAD manufactu 7 Layout @ Solid
I Desitop Sketch Shestmetal
=] My De it ® [ Part Bulk ~
] My Documents e —
=] deskiop-spocaak (1Y, Manufacturing
(=% Working Directory [=] orawing
- £ Format
) Network Neighborhood (5] Roport
(&) Manikin Library £ Oaoram p by CAC
(%] Favorites o] Motebook
4 Markup
pls
Sl o INBE | 20515 | by NTH [omor: [650 U | el 2d catalogs 4
) | e | il e T
[] Use defaut template
oK Cancel
v
< >
» Folder Tree Dane
8a | @®  ® Welcome to FTC Creo Parametric Educational Edition 3.0 M -

o E)e

File ~ Home Q e o
, W

/= = L# (@ Fe)

Select Working Erase Not Model System Play

Hew File Options

Data Seftings ¥ ' Utiities ~
Template
] JE5| inibs_part_solid] Browse.
Common Folders o i  com/
. 4F) | http:diptc. partcommunity: com/ Cmpty =

I In Session @ PARTcommunity 30 CAD manufacture inbs_harn_part

e . s

2 My Documents PARTcommunity 3D CAD n mmns_harn_part

= desktop-spocsak mmns_part_sold b
(% Working Directory Porameters

@ notwork Heighborhood
MODELED_BY
pescrpTON

(&) Manikin Library

(%] Favorites

odels

tified catalogs 4
1

[] Copy associated drawings

oK Cancel
v
< >
» Folder Tree Done
Ba| (@@  * Welcome to PTC Creo Parametric Educational Edition 3.0. ¥
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Step3:select mmns_part_solid and then select OK

=a-=Rdid
File - | | Home
~
= ] ¢ 21
Open Select Working Erase Not  Model System  Play
Directory  Displayed Display Colors  Trail File
Data Settings ~ 1w Utilties ~
gl £
Common Folders . {_ij hitp:/iptc. partcemmunity. com/
[Z] in Session @ PARTcommunity 3D CAD manufacture|
=] Deskiop
¢ My Documents
=1 desktop-spocadk
% working Directory
4 Network Neighborhood [ v e e
(&) Manikin Library | =
(| Favorites
<
» Folder Tree Done

elcome to PTC Creo Parametric Educational Edition 3.0

New File Options
Template

mmns_part_solid

inbs_harn_part

inbs_part_ecad

inlbs_part_solid

mmns_harn_part

mmns_pari_solid

Solid_part_mmks

Parameters

MODELED_BY
DESCRIFTION

Copy associated drawings

Browse...

odels

rtified catalogs

Cancel

~PpO-0

Step4:select a sketch plane

el

v B v MODEL1 (Active) - PTC Creo Parametric Educational Edition = B R
) -
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications D G e
jG J User-Defined Feature J Axis 7 | Revolve A Project L7 O Fn
Gl Ixj- Copy Geometry 2% point = } Sweep J ] style
Regenerate Plane Sketch  Extrude Pattern Boundary Component
- B shrinkwrap 2x Coordinate System # Swept Blend - Blend Freestyle  Interface
Qperations = GetData ~ Datum~ Shapes + Engineering = Editing + Surfaces ~ Model Intent =
o ) I = 3 | %/, 3| g
8o | 3| ) Gl RS, |4 AT s
ModeiTree T - -
(& MODEL1.PRT
L7 RIGHT
7 ToP
L7 FRONT / /
K*PRT_csvs_DEF
=+ Insert Here

L@

* Using C:\Program Files\PTC\Creo 3.0W030\Common Files\templatesimmns_part_solid.prt as the template

Step5:sketch a 2D profile of the model
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H [e] == PRT0004 (Active) - PTC Creo Parametric Educational Edition

LPE-@

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch

g £ % | Centerine VA Line v “jarc v N Filet v |0 offset  § Centerine ~ i@) S+ ¢ ‘H‘ mi g
o 3 Point i Rectangle = ) Elipse ~ 7~ Chamfer ~ | Thicken < Point SN = =
. File Select Construction | _ . Palette Normal —  Feature —— OK Cancel
% System v Jo Coordinate System Mode (G Circle = nuSpline JA Text Project [+ Coordinate System £ b= 4 ft=tl  Reguirements | i
Setup v | GetData Operations = Datum Sketching Editng | Constrain= | Dimension * Inspect Close
o N I ORES 1 1 XY 45 j ]
8o | By| () Q| ® | 4 A |y 2 M (S e
ModeiTree  T| = 5+ u,
[ PrTO0DS PRT § PRT_GSvs DEF " H
LT RIGHT i
7 ToP
L7 FRONT
K¥PRT_CSvS_DEF
*# Insert Here
X 32 Sketch 1
L
. .
5 !
[Be| g8 | » wnen a constraint is active, right click to cycle through lackidisablefenable the constraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping to new By 1selectsd Al -

Step6: extrude the sketch perpendicular to the sketch plane and specify width and direction of
extrusion

Fvo= - PRT0004 (Active) - PTC Creo Parametric Educational Edition = @ X
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude D G T e
.
— & 3,10
O/ A |k [ee 234 C o wFEH s ¥ x et
Placement | Options | Properties
-] N
g° ||
modeiTree  T| - 2 - u,
(X PRT0004.PRT
L7 RIGHT
£ Top
L7 FRONT
B%XPRT_CSYS_DEF
Sketch 1
+ nsert Here
v (BexExirude 1
By | 1selected Sketch -

Step7: select the required surface to add the material of the part and also draw the required
sketch.
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2l Br s PRT0004 (Active) - PTC Creo Parametric Educational Edition = B R

“p0-@

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch

g £ * % | Centerline v~ Line ¥ “jac v N_Filet v |0 Offset | Centerine + i@) S 4 ‘H‘ =Y oW v X
o] = M Point I"f Rectangle ~ ) Elipse + |7 Chamfer + | Thicken < Foint N SN = "
. File Select Construction | _ - Palette Normal —~  Fealure —— OK Cancel
% System - Jo Coordinate System Mode G circle = nuSpline JA Text [J Project "+ Coordinate System 2D L= 4 = Requirements | &

Setup v | GetData Operatons v Datum Sketching Edfing | Constrain~ | Dimension Inspect Chose

EENES) d @ Q@@ & [
g O

ModeiTree  T| = 5+ u,
() PRTO0D4 FRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF

- 4500
> Extrude 1
*# Insert Here
- — s ———=
T B
Ry Ry

W

4000
En éﬁ ® When a constraint is active, right click to cycle through locki/disable/enable the constraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping to new j"‘ 1 selected All -

Step8: extrude the sketch and specify the width and direction of extrusion

2 ') o ) PRT0004 {Active) - PTC Creo Parametric Educational Edition o B R
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude > P e - e
Y
oo'wd
J de~l[se00 -4 7 C I oFEFHS v x .

Placement | Options | Properties

L[
L | R

(7 PRTO004 PRT
L7 RIGHT
 1op
L7 FRONT
BEXPRT_CSYS_DEF

» (P Extrude 1
Sketch 2

* Insert Here

> (Prexruge2

o @@  epSelecta sketch. (If an internal sketch is preferred, the "Edit option can be found n the Placement panel ) # | 1selected Sketeh -

Step9:select the datum plane at the middle of the sketch and with reference to that plane draw
the required shape of the object and then extrude it with require dimensions.
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—

S o EEE

S v
File ~ Model Analysis Annotate Render

g £ e % ! Centerline

il L= 3 Point

. File Select

% sysem 3 Js Coordinate System
Setup v | GetData Operations = Datum

Model Tree

() PRTO0D4 FRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF

(P extrude 1

(M Extrude 2
T o
* Insert Here

Tools

Construction

Mode

PRT0004 (Active) - PTC Creo Parametric Educational Edition

View Flexible Modeling Applications Sketch
W Line ¥ Tjarc v N_Filet v I offset | Centeriine Q) A +He ‘
i Rectangle ~ O Elipse ~ |7 Chamfer ~ |& Thicken 3 Foint N -+ =
o Palette: ) Normal
G circle = nuSpline JA Text [0 Project "+ Coordinate System 22 L= 4 b
Sketching Editng | Constrain~ | Dimension ~
G e <40

Feature —— OK Cancel
Requirements | it
Inspect = Close

FRT_CSvs_DEF
¥

# Section has been reoriented to 2D orientation.

[E|@

Ho -2 H x|y

File = Model  Analysis  Annotate  Render
] = = 2
Placement | Options | Properties

k2
modeiTree  T| - ) v u

(X PRT0004.PRT
L7 RIGHT
£ Top
L7 FRONT
KX PRT_CSYS_DEF

» (M Extrude 1

> (Pextrude 2
L7 oTu
X Sketch 3
*# Insert Here

Tools

View

PRT0004 (Active) - PTC Creo Parametric Educational Edition

Flexible Modeling  Applications Extrude

O 9 v x

Applies and saves any changes you have made in the
feature tool and then closes the ool dashboard.,

FEIEYFIE

L))

1 selected Sketch
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=] SRR A= PRT0004 (Active) - PTC Creo Parametric Educational Edition = B X
=] =
a -
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications o G o
3‘1‘ 3 User-Defined Feature U 7 ads B :ﬂ slo Revolve ) Hole ) Dratt ~ Mirror A Project // CFn 5
o - - { — [y
o= ) I Copy Geometry X% point ~ i sweep + Y Round ~  m) Shell h [ style
Regenerate Plane Sketch  Extrude Boundary Component
> X Delete B4 Shrinkwrap 34+ Coordinate System # SweptBlend i Chamfer ~ 5l Rib Solidify Blend  [CJ) Freestyle  Interface
Operations ~ GetData v Datum~ Shapes + Engineering = Surfaces Hodel Intent =
o] 9@ &|@o

ModeiTree  T| = 5+ u,

() PRTO0D4 FRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF

» (M Extrude 1

» (Bextrude 2
7 o

» Pextrude 3
= Insert Here

BRT_CSYS_DEF

il LJ i1 Smart -

RESULT:

Thus the given model is created by using PTC Creo Parametric 3.0

[CAD/CAM MANUAL]



MREC (A) Mechanical

EXERCISE:5 3D Part Modeling -5

AlIM:

To model the given object using the Extrusion feature as per the dimensions given.
Description of Extrusion Feature:

Base Feature:

¢ The first feature that is created.

¢ The foundation of the part.
¢ The base feature geometry for the box is an extrusion.

)

% The extrusion is named Extrudel.
To Create an Extruded Base Feature:

1. Select a sketch plane.

e =
PTC CREO Work Plane display
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1. Sketcha 2D profile of the model

2. Extrude the sketch perpendicular to sketch plane.

Extruded Boss Feature:

% It Adds material to the part and requires a sketch.

Extruded Cut Feature:

< It Removes material from the part and also it requires a sketch.
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Fillet Feature:

% Rounds the edges or faces of a part to a specified radius.

Fillet feature

Procedure:

Select a sketch plane.(Front, top or Side)

Sketch a 2D profile of the model.

Dimension the model using Smart Dimension icon.
Check the sketch is fully defined.

Extrude the sketch perpendicular to sketch plane.

o kA 0w D PE

6. Use extruded cut feature to cut the solid as given in the drawing.

Result:

Thus the given model is extruded.
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EXERCISE:6 3D Part Modeling — 6
Ex: 2 Exercise on Revolve
AlIM:

To model the given object using the Revolve feature as per the dimensions
given.

Description of Revolve Feature:

Command Manager: Features > Revolved
Boss/Base Menu: Insert > Boss/Base >

Revolve
5

Revalved
Toolbar: Features > Revolved Boss/Base, _BossBsse

Using this tool, the sketch is revolved about the revolution axis. The revolution
axis could be an axis, an entity of the sketch, or an edge of another feature to create the
revolved feature. Note that whether you use a centerline or an edge to revolve the sketch,

the sketch should be drawn on one side of the centerline or the edge.

After drawing the sketch, as you choose this tool, you will notice that the
sketching environment is closed and the part modeling environment is invoked. Similar
to extruding the sketches, the resulting feature can be a solid feature or a thin feature,
depending on the sketch and the options selected to be revolved. If the sketch is closed,
it can be converted into a solid feature or a thin feature. However, if the sketch is open, it
can be converted only into a thin feature.

Now a window with planes will open. now we have to draw a sketch to revolve. Here
we start Select front plane and using sketch option draw a sketch as in the fig. Don’t worry
about dimensions. after drawing sketch draw a center line over Y -axis.
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Fig: Sketch of piston to be revolve

will notice that the view is automatically changed to a 3D view, and the Revolve

Property Manager isdisplayed,after sketching click at done button. in new window click

at revolve button

)

P

6}% Revolve

Revolve Tool

.........

some command line will open and program will ask you to select a reference. here the
reference is a line about which our sketch has to move around. in this practice we will use
that center line that we have draw in sketching.after selecting that line as reference program
will show you a demo of your sketch as a revolved part. if you want to see how your part will
look you may click at “glasses” button if your part is well according to you then

click at done revolving.

[ Al - |

Il Viso v | X

now your part will look like this.
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note : you may draw sketch as you like but remember the conditions to revolve that is a
reference line.

Fig: 8 Revolve Property Manager

Fig:9 Feature Created after revolving to 360 0

Procedure:

1. Select asketch plane.(Front, top or Side)
2. Sketch a 2D profile of the model.
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3. Dimension the model using Smart Dimension icon.
4. Check the sketch is fully defined.
5. Revolve thesketch.

Result:

Thus the given model is drawn using revolve feature.
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EXERCISE:7 Part Modeling & Assembly

AIM: To model the given flange coupling and assemble them by using PTC Creo
Parametric 3.0

PROCEDURE:

Stepl:

Double click on creo parametric and then open new file

Do - e A v
) -
File » Model | Analysis  Annotate Render Tools View  Flexible Modeling  Applications o @ e
jﬂ J User-Defined Feature 7 Axis AL @ oo Revolve fjjl Hole ) Draft ~ A Project £ [F -
5 ahs L _ [y
o I{ Copy Geometry 2% Point ¥ i Sweep WRound v  m] Shel ! | style
Regenerate Plane Sketch  Extrude Pattern Boundary Component
- B shrinkwrap 2x Coordinate System # SweptBlend % Chamfer v il Rib + - Blend [ Freestyle  Interface
Qperations = GetData ~ Datum~ Shapes + Engineering = Editing + Surfaces ~ Model Intent =
F . y %
B | 3| ) New x |8+
modeiTree  T| - ) v u T Sub-type
() PRTO00Z.FRT 7 Layout ® Solid
7 aicHr rj Sketch Sheetmetal
® Part Bulk
7 Top
= _ ] Assembly
o 1Y, manufacturing
A PRT_CSY'S_DEF ] Drawing
] Format
» (" extrude 1 [ Report
L Disgram
» [ extrude 2 i Motebook
o 4 Markup
) de 3
> Extrude 3 Hame: | flange]
L7 pmu2
Common name
» A de 4
Exudelt Use defautttemplate
+ Insert Here
OK Cancel
8o/ @@  * Using C:AProgram Fies\PTC\Creo 3 OWO30\Common Fies'templatesimmns_part_solid prt as the template i Smart -
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Step 2: select ok and select mmns_part_solid and then select OK

259~
File Home
= |
Tv] & v £
New Open Select Working Erase Not Model System Play
Directory  Displayed Display Colors  Trail File
Data Settings w Utilities +
][5
Common Folders &) | nttp./ipte: partcommuntty. com/

[Z] In Session

=] Deskiop

{=} My Documents

=1 desktop-spocadk

% working Directory

4 Network Neighborhood
(&) Manikin Library

(| Favorites

» Folder Tree

=@

@ PARTcommunity 3D CAD manufacture|

ABB 1 s ooty EAM
et

=

Done

® Weicome to PTC Creo Parametric Educational Edition 3.0

New File Options
Template
mmns_part_solid

inlbs_harn_part
part_ecad
inlbs_part_solid
mmns_harn_part
mmns_part_solid
solid_part_mmks

Parameters

MODELED_BY
DESCRIFTION

Copy associated drawings

Cancel

Browse...

o | PxE

odels

rtified catalogs 4
1

~PpO-0

Step4:select a sketch plane

bed

MODEL1 (Active) - PTC Creo Parametric Educational Edition

a & =
a -
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications o G 9
j(& J User-Defined Feature U 7 hads 2 4 o Revolve o, Project 7 [ Fin
o I+ Copy Geometry X% point = i sweep ~ ! 1 style
Regenerate Plane Sketch  Extrude Pattern Boundary Component
= 1 Shrinkwrap K Coordinate System # Swept Blend - Blend Freestyle  Interface
Operations = Get Data Datum = Shapes + Engineering = Editing ~ Surfaces Model Intent =
g 5 [ OIS 3 | %, |l %g
Bo |33 Q| & |4 A irs
Model Tree

M-B- &

(3 moDEL1PRT
L7 iGHT
7 Top
L7 FRONT
K*PRT_csvs_DEF
* Insert Here

- @

. (FRT_C,SYS_D F

4

# Using C:\Program Files\PTC\Creo 3.0W030\Common Filestemplatesimmns_part_solid.prt as the template

Step5:sketch a 2D profile of the model
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H o Br s FLANGE1 (Active) - PTC Creo Parametric Educational Edition = B X
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch o G v 9

g £ % | Centerline VA Line v “jarc v N Filet v | Offset | Centerine ~ /2> S+ ¢ ‘H‘ O g i v X

i Y L.

] M Point - i Rectangle ~ O Elipse ~ |7 Chamfer ~ |& Thicken 3 Foint SN = o

. File Select Construction | R Paletie Normal ~  Feature [ OK Cancel

@2 system - Jo Coordinate System Mode G circle = U Spline [A Text Project [+ Coordinate System £ b= 4 ! Requirements | i
Setup v | GetData Operations = Datum Sketching Edting | Constrain~ | Dimension = Inspect ~ Close

a @ lag =] =1ow|

EENES) al @ Q|3 & e

Model Tree AR

(0 FLANGE1.PRT
L RIGHT
7 Top
L7 FRONT
K¥PRT_CSvS_DEF
*# Insert Here
X 32 Sketch 1

177.00

PRT_CSVS_DEF

o |G | * When a constraint is active, right click to cycle through lockidisablefenable the constraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping to new Fy 1 sekctd Al -

Step6: extrude the sketch perpendicular to the sketch plane and specify width and direction of
extrusion

Cs] By o= ¥ FLANGE1 (Active) - PTC Creo Parametric Educational Edition = B3R
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude Ie] e - o
A
— s
&) ik~ (znm [+ 04 C Il @G 60 v x Datum
Applies and saves any changes you have made in the -
Placement | Options | Properties feature tool and then closes the tool dashboard.

NS Q@ e a0, 4 | % [EE

modeitree T v [E] + T
(T FLANGE1.PRT
L7 RiGHT
L 1op
L7 FrONT
K PRT_CSvS_DEF
X Sketch 1
% Insert Here
» (Asextrude 1

i @ &y | 1 selectzd Sketeh -

Step7:select the required surface to add the hub and then draw the hub in 2d sketch plane and
extrude it by giving the required dimensions
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= H s Rl o 24 =gk E}‘ L FLANGE1 (Active) - PTC Creo Parametric Educational Edition

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch

Ul
=

g £ b k | Centerline VA~ Line v “jac v N_Filet v |0 Offset | Centerine + ("2> |- & ‘H‘ mH ’
= L= =Y M Point i Rectangle ~ O Elipse ~ |7 Chamfer ~ |& Thicken 3 Foint N -+ = ot
. File Select Construction . Palette i Normal —~  Fealure —— OK Cancel
% system 3| - Jo Coordinate System Hode (Gicircle ~ N Spine  JA Text [ Project s Coordinate System 22 L= 4 ft  Requirements | iiE
Setup v | GetData Operatons v Datum Sketching Edfing | Constrain~ | Dimension Inspect Chose
- D | g = | x| ==1lce|
§q =& Q& | d 0, =R il - P
&y |
ModeiTree  T| = 5+ u,
(0 FLANGE1.PRT
L RIGHT
7 ToP
L7 FRONT
KX PRT_CSvS_DEF
(P extrude 1
*# Insert Here
N 3% Sketch 2

8o/ g8 | » Wihen a constraint is active, right click to cycle through lockidisable/enable the consiraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping o new | 1 selected Al -

Ho -2 H x|y FLANGE1 (Active) - PTC Creo Parametric Educational Edition = B R
File = Model  Analysis  Annotate  Render Tools View  Flexible Modeling  Applications Extrude =0 9 - 9
0/A dk-=e 234 @ C noEH® | x .

Placement | Options | Properties
A Q& &|d0 R E W38
modeiTree  T| - ) v u

(0 FLANGE1.PRT
L7 RIGHT
£ Top
L7 FRONT
KX PRT_CSYS_DEF

» (M Extrude 1
X Sketch 2
=+ Insert Here

b (Petextrude 2

i B | 1 selected Sketch -

Step 8:select the required surface to add the material and then draw the hub in 2d sketch
plane and extrude it by giving the required dimensions
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= H v Cuv i =gk E}‘ L FLANGE1 (Active) - PTC Creo Parametric Educational Edition

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch
g £ 8 k | Centerline VA~ Line v “jac v N_Filet v |0 Offset | Centerine + ("2> S 9 e ‘H‘ mH ’
o Lesd . Point i Rectangle ~ O Elipse ~ |7 Chamfer ~ |& Thicken 3 Foint N -+ = v
. File Select Construction N Palette i Normal —  Featrs —— OK Cancel
@2 system [ v | J Coordinate System Node Cjcicle »  NusSpine  [A Text O Project ™+ Coordinate System 22| L4 ft!  Requirements | %
Setup v GetData Operations = Datum Sketching Ediing | Constrain~ | Dimension = Inspect Chose
T
- D | g = | x| ==1lce|
§q =& Q& | d 0, =R il - P
‘0
ModeiTree  T| = 5+ u,

(0 FLANGE1.PRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF

» (M Extrude 1
» (Bextrude 2

> (Pexirude 3

X3 Sketch 4

[E|@

® When a constraint is active, right click to cycle through lockidisable/enable the constraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping to new «

Ho -2 H x|y FLANGE1 (Active) - PTC Creo Parametric Educational Edition

File = Model  Analysis  Annotate  Render Tools View Flexible Modeling  Applications Extrude

S N v x

Placement | Options | Properties

N e Q& e @0
Model Tree

M-8
(0 FLANGE1.PRT

L7 RIGHT

7 Top

L7 FRONT

KX PRT_CSYS_DEF

» (M Extrude 1
» (Pextrude 2
» (Pextrude 3

X Sketch 4

= Insert Here
b (Bstexruce «

Datum

1 selected

L))

Sketch -

Step9:select the required surface to remove the material in the hub and then draw the shaft in
2d sketch plane and extrude it by giving the required dimensions
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SHo -2 PGy FLANGE1 (Active) - PTC Creo Parametric Educational Edition
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch
g £ b % | Centerline A Line ¥ “jac v N_Filet v |0 Offset | Centerine + @ i
o L= = 3 Point i Rectangle ~ O Elipse ~ |7 Chamfer ~ |& Thicken 3 Foint )
. File Select Construction . Palette Feature —— OK Cancel
% system 3| - Jo Coordinate System Mode G circle = U Spline [A Text [ Project s Coordinate System £ Requirements | ‘i
Setup v | GetData Operations = Datum Sketching Editng | Constrain~ | Dimension ~ Inspect = Close

& @ alalan

ModeiTree  T| = 5+ u,

(0 FLANGE1.PRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF

(P extrude 1

(Pextruge 2

* nsert Here
N2 Sketch 3

8o/ g8 | » Wihen a constraint is active, right click to cycle through lockidisable/enable the consiraint. Use Tab key to toggle active constraint. Press and hold Shift to disable snapping o new | 1 selected Al -

Ho -2 Ty x v FLANGE1 (Active) - PTC Creo Parametric Educational Edition

File = Model  Analysis  Annotate  Render Tools View  Flexible Modeling  Applications Extrude =0 9 - 9

o N
dla |- we  [-54 7 C 4 1 0]F[FH 0 v x

Placement | Options | Properties

R al@ a2 0E ] wEE
modeiTree  T| - ) v u

(0 FLANGE1.PRT
L7 RIGHT
£ Top
L7 FRONT
KX PRT_CSYS_DEF

. 14060
> (Pextrude 1

» (Pextrude 2

» (Bedtrude 4
7 Sketch 5
* Insert Here

b (PrExuge s

§= ﬁ & Select a sketch. (If an internal sketch is preferred, the "Edit” option can be found in the Placement panel ) By | 1 selected Sketch -
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DEEdo -8~ FLANGE1 (Active) - PTC Creo Parametric Educational Edition o B ®

& -
S -
Flev | Model & Analysis Annotate Render Tools View  Flexible Modeling  Applications 0o-0 Le-@

j{l 5 o UserDefined Feature J Axis /\_, :’ 5o Revolve £ Hole: o Draft ~ & Project // O Fin )

B Is{- Copy Geometry X% Point = 4 Sweep ~ WRound v =] Shell [ style
Regenerate Plane Sketch  Extrude Boundary Component
- X~ (B shrinkwrap B Coordinate System # SweptBlend % Chamfer + 45/ Rib ~ Blend [0 Freestyle  interfacs

Operations v Get Data v Datum ~

Shapes ~ Engineering

Qe @ |@|0d,

Surfaces ~ Model Intent + [~

modelTree T ~ [2) + 4,

(9 FLANGE1.PRT
L7 RIGHT
O 1op
L7 FRONT
K= pRT_csvs_DEF

» Bextruge 1
> Bearude 2
» Pextrude 3

» Bextrude s

b 23] Pattern 1 of Extrude &
* Insert Here

(8] @@ = Pattern creation successful

[ ] j 1 Smart -

Create key way in the hub

DBHdo-a-E8-xs3 v F1 {Active) - PTC Creo Parametric Educational Edition

File » Model Analysis Annotate Render Tools View Flexible Modeling Applications >0 e - o

a c g ; i ) - fror T3] d .
JG {2 © 3 User-Defined Feature U 7 Axis /‘\J :’ Slo Revolve il Hole: &) Draft Mirror d oA Project .‘// i

Is" Copy Geometry X% point ] Sweep ~ W Round v [ Shell 51 Trim Thicken (3 style
Plane Shetch  Extrude Pattern Boundary _ Component
[ Shrinkwrap 3+ Coordinate System # sweptBlend i Chamfer ~ &l Rib ~ »  (GlMerge A y  Blend [ Freestyle Interface

Regenerate

Operations = Get Data ~ Datum~ Shapes ~ Engineering ~ Editing ~

Q & |40

Surfaces ~ Model Intent ~

xs

AFERE

Model Tree ‘ﬂ MEREHY
(@ F1.pRT
T RiGHT
L Top
L7 FrONT
K PRT_CsvS_DEF

v

i’ Extrude 1

v

(P extrude 2
b (Pedtrude 3
» (Bedtrude 4
¥ (33| Pattern 1 of Extrude 5

» (Bextruce s
* Insert Here

[Ee| @@ = Feature redefined successfull.

Stepl0:similarly create another flange and save it as another file
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ODEHdo-u~-23F >3~ PRT0002 (Active) - PTC Creo Parametric Educational Edition = B 32
£ -
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications o G o
g€ & £} User-Defined Feature /7 7 ads B :ﬂ sl Revolve 1l Hole & Draft // ClFn
o I+ Copy Geometry X% point = i sweep ~ W Round ~ W) Shell (1] style
Regenerate Plane | Sketch  Extrude Boundary _ Component
- B4 Shrinkwrap $* Coordinate System # SweptBlend 1 Chamfer = {5 Rib + Blend [ Fresstyle  interface
Operations = Get Data ~ Datum~ Shapes + Engineering = Surfaces ~ Wode! Intent =
EIEYEYP]
ModeiTree  T| = 5+ u,
() PRTO00Z FRT
L RIGHT
7 Top
L7 FRONT
KX PRT_CSvS_DEF
> (Pextrude 1
» (Bextrude 2
> (Pexrude 3
b (Pedtrude 4
= Insert Here
F @ * PRT000Z has been copied to FLANGEZ ] f ) Smart -

DEHo-a-# 8=~ F2 (Active) - PTC Creo Parametric Educational Edition

File = Model | Analysis Annotate Render Tools View Flexible Modeling  Applications

jt‘ =} User-Defined Feature U 7 s f\/ i’ 5io Revolve: 1l Hole £ oraft ~ B // O Fir
o= B I Copy Geometry X% Point ) Sweep ~ WRound v W] Shell [ style
Regenerate Plane Sketch  Extrude Pattern Boundary __ Component
- X Bl shrinkwrap L coordinate System # SweptBlend 3 Chamfer ~ 5l Rib v - Blend [ Freestyle  interface
Operations + GetData v Datum~ Shapes + Engineering Surfaces + Nodel Intent
- @ | = | %/, =1
% & m ERE IS E
]
modeiTree  T| - 2 - u,
(@ F2prRT
L7 RIGHT
7 Top
L7 FRONT

B%XPRT_CSYS_DEF
> (Pextruge 1
> (Pextruge 2
> (Pextrude 3
> (Pextrude 4
» (33| Pattern 1 of Extrude 5

» (Pextrude s
* Insert Here
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o~ a o - ” P - u
DEdoo-a-2Frx=i~+ FLANGEZ (Active) - PTC Creo Parametric Educational Edition = B % -
~00-0 ©
Flev | Model | Analysis Annotate Render Tools View  Flexible Modeling  Applications grma- |
ind -
] T 5 7ae i \ Draft + jiror T3 Extend 3% %
Jﬁ o UserDefined Feature J Axis e :’ 5o Revolve fil Hole ) Draft Wiror [+ Extend 5, Project .‘// O Fn 5] 2 Replace
0= s Copy Geometry % Boint + & sweep ~ V¥ Round ~  [m] Shell Bl Trim =7 Offset Thicken [ style Chonge || Iy select~
Regenerate Plane Sketch  Extrude attern Boundary Component tyles
- (B4 shrinkverap ¥« Coordinate System # sweptBlend < Chamfer + 45/ Rib TlMerge (N intersect (f Soidity | Blena  [J) Freestyle  interfacs || Edting |
Operations + Get Data ~ Datum = Shapes + Engineering Editing ~ Surfaces ¥ Model Intent = Ca
5 |3 AEAEIEIES
Q@& & (@0 @ Y28
() FLANGEZ PRT
L7 RiGHT
L top
L7 FRONT
2% PRT_CSYS_DEF
» Bextruge 1
> Bearude 2
» Pextrude 3
» Bextrude s
» 23] Pattern 1 of Extrude S
* Insert Here
:
@
p— =
* Pattern creation successful L] Smart -
i # # —r—;

Stepll:create a shaft and then select required sirface of the shaft to create a keyway on the
shaft and save it

Ho -2 Py x|y

PRTO0003 (Active) - PTC Creo Parametric Educational Edition

= B R
File = Model  Analysis  Annotate  Render Tools View  Flexible Modeling  Applications Extrude =0 9 - 9
O Lk ~|[me -5 A C Il O 0 v x Datum
Placement | Options | Properties
= [ORES
PlmE Q@ &30,
modeiTree  T| - ) v u
() PRTO003 PRT
L7 RIGHT
7 ToP
L7 FRONT
K*PRT_csvs_DEF
Sketeh 1
*+ Insert Here
v (Prexrude 1
& @ B | 1 selected Sketch -
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J : H (2] =gk L PRT0003 (Active) - PTC Creo Parametric Educational Edition = B 3
a -
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications o G e
j“ o 3 User-Defined Feature U 7 hads 7 W o Revolve T7jl Hole ) Draft = 5 Project 1 Fin
\ i =
&l I+ Copy Geometry 2% Point = i sweep ~ W Round v [m] Shell 7] style
Regenerate Plane Sketch  Extrude Boundary Component
- D B4 Shrinkwrap h# Coordinate System # SweptBlend 1 Chamfer = {5 Rib ~ Blend [ Fresstyle  Interface
Operations = GetData v Datum = Shapes + Engineering = Surfaces Hodel Intent =
o Y ql|® | & ]
8o | 3| ) Q| & ||

ModeiTree  T| = 5+ u,

() PRTO003 FRT
L7 RicHT
£ Top
L7 FRONT
K PRT_cvs_DEF

> (@ extrude 1
> [(Bexdrude 2

¥ Round 1
¥ Round 2

* Insert Here

Stepl2:create a keyway and save it

=] B PRT0004 (Active) - PTC Creo Parametric Educational Edition = B R
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Skerch p G T e
g £ % | Centerine . VA Line = “Jac~ N_Fiet v~  |Joffset | Centerine ~ ;9 oo
o . Point [=i Rectangle = <) Elipse v 7~ Chamfer v | Thicken ! Point i ;
. File Select Construction | _ . Falstts Featre . OK Cancel
& system + | J Coordinate System  Mode Gicicle ¥ ~usSpine  [A Text Project f-» Coordinate System r£ Requirsments | i
Setup ~  GetData Operations = Datum Sketching Eding | Constrain~ | Dimension Inspect ~ Close
o 3 Q| ®) | | | eI
B |3 (3 Q& 8|04 RN 3
modeiTree  T| - 2 - u,
(X PRT0004.PRT
L7 RIGHT
L7 1o
L7 FRONT T
B%XPRT_CSYS_DEF i
# nsert Her
X 3 Sketch 1
PRT.GSVS_DEF
1 400
ann
i

2o | @ | ® Section has besn reorisnted to 2D orientation
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[e] =gk v PRT0004 (Active) - PTC Creo Parametric Educational Edition

= B X

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude nge
7
— S\
] 4 k|~ ([25.00 -4 C Il ®ff[F 60 | x Datum
Placement | Options | Properties

1 Y
|2 3

[ = ] | x4 =1
d|® Q|03 E w38
ModeiTree  T| = 5+ u,
() PRTO0D4 FRT

L7 RicHT

7 Top

L7 FRONT

¥ PRT_cvs_DEF

X Sketch 1

= insert Here

g T Csvs DEF
-

By | 1 selected Sketch

ODeEdo B = ¥ PRT0004 (Active) - PTC Creo Parametric Educational Edition = B o2
& -
File » Model Analysis Annotate Render Tools View Flexible Modeling Applications o e e
jx‘ op § User-Defined Feature U 7 Axis .r\\/. i o Revowve i Hole & Draft = J{ I Fn
o I+{ Copy Geometry £ Point ¥ . i Sweep ~ ¥ Round v  m] Shel T 0 i ] style
Regenerate Plane , Sketch  Extrude Pattern Boundary Component
- D Bl Shrinkwrap %+ Coordinate System # SweptBlend ) Chamfer ~ =/ Rib ~ Solidif Blend  [)) Freestyle  Interface
Operations Get Data ~ Datum ~ Shapes + Engineering + Surfaces ~ Wodel Intent +
& a @ |a 1
u 4 )
AN 1 ® & ,
L | R
(3 PaT0004.PRT
T RiGHT
L7 Top
L7 FRONT

BEXPRT_CSYS_DEF

> (P Extrude 1
=+ Insert Here

T_CSYS_DEF

Stepl3:create a bolt and save it
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= H BHrox E/" v PRT0005 (Active) - PTC Creo Parametric Educational Edition

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Sketch
g £ % ! centerine VA Line + “Jac w N_Fietv | Offset | Centerine i@) S [ mH =
Ly

0 3 Point =i Rectangle = ) Elipse ~ 7~ Chamfer ~ | Thicken < Point SN = i
. File Select Construction | _ N Palette Normal Feature — | OK | Cancel
% System - Jo Coordinate System Node Gjcircle ~ MU Spine  JA Text Project T+ Coordinate System £ b= 4 f  Requirements |

Setup v | GetData Operations = Datum Sketching Editng | Constrain~ | Dimension ~ Inspect = Close

ol @ | 1 =k 22 =T
EENES) Q| &S, |02, &) %< g, 58] v 0K
— Save the cl d exit
ModeiTree  T| = 5+ u, - n = ave the section and exi

() PRTO0DS FRT
L7 RIGHT
£ Top
L7 FRONT
:—)6* PRT_CSYS_DEF Ly L
Y

X 32 Sketch 1

FRT_CSVS_DEF "
i

o

L =

=i ¥ PRT0002 (Active) - PTC Creo Parametric Educational Edition = B R

File » Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude > P e - e
S

pr— — \'9
@] dk - [ne %4 C Il [0 F[FH 0 v x .

Placement | Options | Properties

il et 3]
Model Tree "j‘g MEREH
(3 PaTo002 PRT
T RiGHT
L top
L7 FRONT
BEXPRT_CSYS_DEF
Sheten 1)
= Insert Here
¥ (H:extrude 1
A xesketen 1

n 1 selected Sketch -

Step13:Select a datum plane as shown in figure and with reference to that draw the required
shape to smooth the bolt surface using revolve option nad save it
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j (=] H SRR = == PRT0005 (Active) - PTC Creo Parametric Educational Edition

= B X
£ -
File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications o G 9
:“t‘ =} User-Defined Feature U ‘r‘ Roxis ,-\J A 5o Revolve )l Hole &) Draft v Mirror [+] Extend 3% Project .‘K/ [ Fin i)
&l «  Is- Copy Geometry 2% Point = i Sweep ~ W Round ~ M) Shel mim Thicken [ style
Regenerate Plane | Sketch  Extrude Pattern Boundary _ Component
> + | [B Shrinkwrap 34+ Coordinate System # SweptBlend i Chamfer ~ 5l Rib - Merge Intersect Blend  [CJ) Freestyle  Interface
Operations = GetData v Datum~ Shapes + Engineering = Editing Surfaces ~ Hode! Intent =
AN
d e e dol
ModeiTree  T| = 5+ u,
() PRTO0DS FRT
L7 RIGHT
7 Top
L7 FRONT
K PRT_cvs_DEF
» (M Extrude 1
7 pTut
io Revolve 1
= Insert Here
Smart -

DEHo- -8 -x~

PRT0002 (Active) - PTC Creo Parametric Educational Edition

File » Model Analysis Annotate Render Tools View Flexible Modeling Applications

§ User-Defined Feature U 7 Axis r\J :’ sl Revolve: il Hole ) Dratt Mirror

| Copy Geometry % Point

& Project .‘/f O Fa g

f Sweep ~ Y Round v  [m] Shel Trim Thicken [ style
Plane Sketch  Extrude Pattern Boundary _ Component
| [B1 shrinkwrap %+ Coordinate System # sweptBlend i Chamfer ~ 5l Rib ~ = Merge Intersect Solidify Blend [ Freestyle  Interface
Operations ~ Get Data v Datum ~ Shapes v Engineering + Editing + Surfaces ~ Mode! Intent =
g [ Qalalao, FER
]
Model Tree ‘ﬂ MERE:-

(3 PaTo002 PRT
T RiGHT
L top
L7 FRONT
BEXPRT_CSYS_DEF

(P Extrude 1
L7 ot

v

0 Revolve 1

> (Pexrude 2
=+ Insert Here

Step 14:create a nut and save it
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z (3] ul—R e BOLT {Active) - PTC Creo Parametric Educational Edition = # R

File ~ Model Analysis Annotate Render Tools View Flexible Modeling Applications Extrude “ P G - 9

O/@ - 24 7@ C Il oo ¥ x

Datum
Applies and saves any changes you have made in the

Placement | Options | Properties feature tool and then closes the tool dashboard.

NG alala]a0/3 & aEE
ModeiTree  T| = 5+ u,
(0 poLTRRT
L7 RicHT
7 Top
L7 FRONT
K PRT_cvs_DEF

» (M Extrude 1
7 pTut

» i Revolve 1
7N Sketch 3
* Insert Here

> (Pexiugez

B | 1selected Sketeh -

Step15:now open creo parametric and select assembly in type design in sub type and give the
name of the assembly and then select ok.

=R PTC Creo Parametric Educational Edition = B R
File ~ Home

“po-@

Data Settngs > '« Utilties

AEE

Common Folders T Subtype
[T In Session O |7 Layout (@) Design
I Deskiop 5 Sketch

(=} My Documents o Fat

0] Assembly
§=) desitop-spocs3k (1Y, Manufacturing
% Working Directory [&] Drawing
e ] Format xternal simplified representation
=) Network Nelgnbarhoo EH Report () Configurable medule
{5 Manikin Library -E Diagram () Configurabie product
(%] Favorites. Hotebook ) ECAD

O [ Markup

Name: |asm0001

Common name:

[] Use default template

oK Cancel

P Folder Tree

Stepl6:select mmns-ass-design and then ok
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7§ User-Defined Feature J Axis " o Revolve fill Hole & Draft ~ S, Project ‘_// O Fan B
' | - Mol
15" Copy Geometry % Point ¥ {2 Sweep ~ ¥ Round v ] Shell b Thicke 1 style
Regenerate Plane Skefch  Extrude Bounda Component
- BL Shrinkwrap 2+ Coordnate System # SweptBlend % Chamfer ~ 45 Rib Blend [ Freestyle  Interface
Operations ~ Get Data ~ Datum Surfaces ¥ Model Intent
Template
B B &)
a - mmns_ssm_design Browse...
Model Tree - -
T’ = inlbs_asm_design -

() FLANGEZ PRT
LI RIGHT
O 1op
L7 FRONT
3% PRT_CSYS_DEF
» P exruge 1
» P exruge 2
» (Pextrude 3

» Bextrude 4

b 23] Pattern 1 of Extrude &
* InsertHere

inlbs_asm_ecad
inlbs_flat_harmess
mmis_asm_design
mmns_asm_design
mmns_flat_harness

Parameters

WODELED_BY
DESCRIPTION

[] Copy associated drawings

* FLANGEZ has been copied to F2.

Stepl7:import the required part to do assembling

DeEedo- ®Hr 2 v ASMO001 (Active) - PTC Creo Parametric Educational Edition = &#@ R
o -
File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework o e o
U3 ] " i Axi H o iew 3
g =54 k_u A @ g 5 A A i l) ‘ 120 Exploded View | ) % [ a gdﬂ
&l 15 =2 X% point - # Extrude Hm T ¥y =
Regenerate Assemble Drag Plane Sketch Fattern  Manage Section Appearance Display Component Publish  Family Bilof  Reference
- Bt - Compenents 2K Coordinate System 5o Revolve Viewsv Galery v SI'EdtPoston  Stylew Interface Geometry Table d=  Materials Viewer
Operations v Get Data ~ E Assemble [ Datum v Cut& Surface ¥ Modifiers + Model Display Mode! Intent + Investigate ~
n D | PYR ==
. al @ | g Yy 2
B |2 @) o 12 Assemble A ®|Q 4|06 AR B
= Add a component to the assembl!
Model Tree ‘T} o= F Z ¥

O AsM0001.ASM

N

[ﬁ A\ You are leaving this component as packaged

Step18:Select the required file from the saved files and then open
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s R v
£ -
File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework o G e
a i / Hole - 0 A
9 & -“_U = @ U £ s o e | l) ‘ 129 Exploded View | e g‘ El [ a gdﬂ
&l I+ = % Point ~ A Extrude el T s . e
Regenerate Assemble Drag Plane Sketch Pateri  Manage Secton Appearance Display Component Pubish  Family Bilof  Reference
- B - Components Xx Coordinate System slo Revolve Views~ v  Galeryv GFEdtPoston  Stylew  interface Geometry Table d=  Materials Viewer
Operations v GetData ~ Component ¥ Hode! Intent ~ Investigate +
Open x
2 | = 4 |+ ~ | » deskop-spocd3k » (C:) # Users b mecad b Deskiop » v |43/ |search..
il ] |
modeitree |+ [ v Pa W Organize ~ 5 Views v T} Tooks v [
g Common Folders ) AutoCAD
ASM0001.ASM . .
I i Session ) Course Fiie_A Jyothi
) New foider
[ Desktop
. flange couping
(= wy Documents (%] Course Fils_A Jyothi zip
2 desktop-spoc43k ([ botprt
4 Working Directory () riprt
2 Network Neighborhood O r2pr
[ flange? prt
Maniin Libra
=l & () fiangez.prt
(%] Favorites & keyprt
(J nutprt
(3 shaftt.prt
File name: f1.prt Date modified: 18-Nov-17 11:40:02 AN Praview ~
File name: | f1.prt Type| Creo Files (prt, .asm, |~ | Su
b Folder Tree | Open 7| Open subset.. Cancel
e @ M, You are leaving this companent as packaged. e # Smart -

Manikin  Tools

Properties

File » Model Analysis Annotate Render
| User Defined - £ sotomatic |+
Placement | Move | Options | Flexibility

2 y

il ] | E3

L | R

& asmo001.45M

View

ASMO0001 (Active) - PTC Creo Parametric Educational Edition

Applications Framework Component Placement

hs| STATUS : No Constraints = || [

Il v x

= B R
pPG-0
Datum

@ Selectany reference for auta ype consiraiing.

Step 19:Similarly get the 2" part to do the assembling and select the coinside option and

select the parts and axis to be coinsided.
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ASMO0001 (Active) - PTC Creo Parametric Educational Edition

File v Model Analysis Annotate Render Manikin Tools View Applications Framework Component Placement

~08-0

User Defined ~ I Coincident -

/’ é, STATUS : Fully Constrained (@ | | ] Il + x

Applies and saves any changes you have -
Placement | Move | Options | Flexibility | Properties <L g a=ah)

made in the feature tool and then closes the

- . . tool dialog box.
3 Qe | |dd %,
Model Tree -8 i
x| - Zh +
& aswmooot.Asn
[0 0FL1PRT

F ﬁ’ & Select any reference for auto type constraining

Step 20: similarly do the assembling of remaing parts to get complete of the flange coupling
assembly

(¥ (=] H AEcRS 4 =i > 4 ASMO0001 (Active) - PTC Creo Parametric Educational Edition

File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework

22 3 WE g /= A ] BP0 E g e

Regenerate Assemble Drag Pane Sketch Paftern  Manage Section Appearance ~ Display Component Publish Famiy Bilof  Reference
- X B - Components 3% Coordinate System slo Revolve - Views~ v  Galeryv GFEdtPoston  Stylew  interface Geometry Table d=  Materials Viewer
Operations v Gat Data ~ Component Datum v Cut & Surface *  Modifiers ~ Wode! Display = Wode! Intent Investigate +
Nie = | %
A& 9 do)EE %
Model Tree T-8- i
X T o+
O Aswoont.Ash
(P orLieRT
P mrzpRT
(O okev.pRT
(# okev.PRT
F @ M, You are leaving this companent as packaged. ° # Smart -
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[} (=] H SRR B ¥ ASMO0001 {Active) - PTC Creo Parametric Educational Edition

File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework

i3 MIw ol Al of HP €t Hem)

5% X% point

B s
Regenerate Assemble Drag Plang Y Sketch . Pattern Manage Section Appearance . Display Component Publish  Family Bilof Reference
- X Bl - Components x Coordinate System dlo Revolve - Viewsv v  Galeryv Sf'EdtPostion  Stylev Interface Geometry Table d=  Materials Viewer
Operations v GetData ~ Component ~ Datum ~ Cut & Surface ~ Modifiers ~ Model Display * Wodel Intent Investigate ~

EIREY]E)

Model Tree -8~
»n

O AsH0001.ASM
(J oFL1.PRT
O FLz2pRT
(O okev.pRT
(J oKev.PRT
(0 OSHAFT1.PRT

g/ [ga] | * Component packaged successfully.

OEdo-co-23T~ x|~ ASM0001 ({Active) - PTC Creo Parametric Educational Edition = B R

File » Model Analysis Annotate Render Manikin Tools View Applications Framework >0 e - o

‘:Et“ j 2 E g @ /7 £ adis B 3:\;& E _|) ‘ E']Expluded\fiew ’ 1;”-} ﬁ" El; gdﬂ

Iy &% point v

Regenerate Assemble Drag Plane Sketch : Fattern  Manage Section Appearance Display Component Publish  Family Bilof  Reference
- B - Components 3% Coordinate System ol Revolve - Views~v v  Galeryv Sf'EditPostion  Stylev Inferface Geometry Table d=  Materials Viewer
Operations ~ Get Data = Component ~ Datum v Cut & Surface ~ Modifiers ~ Model Display ~ Model Intent ~ Investigate

Q&9 @0,

Model Tree

=
B i)

+ 7

& Asmo001.A5M
(9 OFLY.PRT
(P mr2.pRT
0 oKev.PRT
(J oKev.pRT
(# OSHAFT1.PRT
(O osHAFT1.PRT

F 53 i\ You are leaving this component as packaged. #
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LEH» -«

fuge R 2R 4 ASMO0001 (Active) - PTC Creo Parametric Educational
File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework
a ;A Hol
e B 2 o @ @ 7] § &= A, e =)
&l I+ = g % Point ~ (' Extrude
Regenerate Assemble Drag Plane Sketch - Pattern Manage
- Bl - Components. x Coordinate System slo Revolve > Viewsy v
Operations ~ Gt Data ~ Component ~ Datum~ Cut & Surface ~ Modifiers ~
Qelala

Model Tree

R
By

O AsH0001.ASM
(J oFL1.PRT
P mrzpRT
(O okev.pRT
(# okev.PRT
(0 OSHAFT1.PRT
(3 OSHAFT1.PRT
¥ onpRT

)
+

* Component packaged successfully.

[E@@

Edition

Gallery +

23 Edit Postion

Wode! Display =

_u ‘ 12 Exploded View ’

Section Appearance Display  Component

Style -

& =0

Publish  Family
Geometry Table d=

Bill of
Materials  Viewer

Reference
Interface

Wode! Intent Investigate

DEHo-c-22 8- =~
File » Model Analysis Annotate Render Manikin Tools View
3¢ A 3 ] 1o} @ 7 s
= 5 S 2% point
Regenerate Assembl Drag Plane
- B - Components. ¥ Coordinate System
Operations ~  Get Data ~ Component ~ Datum ~
F [
Model Tree T-8- %%
x|~ i +
& Asmo001.A5M
(9 OFLY.PRT
(3 mr2pRT
(# okev.PRT
(3 okev.pRT

(J DSHAFT1.PRT
(O osHAFT1.PRT
(J onpRT

¥ usoLTPRT

ASMO0001 (Active) - PTC Creo Parametric Educational Edition

Applications Framework
g ] Hole P
. (' Extrude o
Sketeh Fattern  Wanage
oo Revolve viewsv v

Cut & Surface ~  Modifiers

EICYEY]

Section Appearance

Gallery ~

23" Edit Position

Wodel Display =

),

D ‘ 120 Exploded View ’

Display
Style ~

= B R

~0B-0

o & @) A
— £l
Component  Publish ~ Family Bilof  Reference
interface  Geometry Table d=  Malerials Viewer

Model Intent ~ Investigate ~

| @

* Component packaged successfully.
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DB Ho -2 P>+ ASMO0001 (Active) - PTC Creo Parametric Educational Edition .

File ~ Model Analysis Annotate Render Manikin Tools View Applications Framework el e e o

3¢ B a2 Wﬂ 7| @ /7 7 s A ] Hole H _u ‘ 129 Exploded View ’ 0 ﬂ’ El 0 :-:-F gdﬂ
= 15 = X% point ~ (7 Extrude To atus B =
Regenerate Assemble Drag Plan ketch Pattern Manage Section Appearance Display ~Component Publish  Famiy Bilof  Reference

e s
Bt - Components 3 Coordinate System oo Revolve v Viewsv v  Galery~ SfEdtPostion  Stylev  inferface Geometry Table d=  Materisls Viewer

Operations v GetData ~ Component « Datum ~ Cut & Surface ¥ Modifiers v Model Display « Model Intent v Investigate ~
&= Q& | |E|0|03 6] %3]
| )

Model Tree TJ - g -

O Aswoont.Ash
(P orLieRT
[ mri2pRT
0 oKev.PRT
(3 okev.PRT
(¥ OSHAFT1.PRT
(3 OSHAFT1.PRT
» [33] @ pattern 1 of N.PRT
» [33|wpattern 2 of BOLTPRT

F @ Pattern creation successful 1) Smart -

RESULT:

Thus the given model is created and assembled by using PTC Creo Parametric 3.0
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COMPUTER-AIDED MANUFACTURING

Computer-Aided Manufacturing (CAM) is the use of computer-based software tools
that assist engineers and machinists in manufacturing or prototyping product components. Its
primary purpose is to create a faster production process and components with more precise
dimensions and material consistency, which in some cases, uses only the required amount of
raw material (thus minimizing waste), while simultaneously reducing energy consumption.
CAM is a programming tool that makes it possible to manufacture physical models using
computer-aided design (CAD) programs. CAM creates real life versions of components
designed within a software package

NC Technology

Numerical Control (NC) is a software-based machine tool control technique
developed at Massachusetts Institute of Technology (MIT) in early 1960s. It has now evolved
into a mature technology known as Computer Numerical Control (CNC). Although major
applications of CNC even today continue to be in machining, it finds applications in other
processes such as sheet metal working, non-traditional machining and inspection. Robots and
Rapid Prototyping machines are also CNC controlled. In fact, any process that can be
visualized as a sequence of motions and switching functions can be controlled by CNC.
These motions and switching functions are input in the form of alphanumeric instructions.
CNC is the basis of flexible automation which helps industries cut down time-to-market and
enables launch of even low volume products. Unlimited muscle power, unmanned operation,
independent axes coordinated through software, simplified generic tooling even for the most
complex jobs and accurate construction are some of the salient features of CNC.

CNC Machining

Automats and Special Purpose Machines (SPMs) require special cams/ templates and
clutch settings for each part. Manufacture of these cams/ templates is costly and slow.
Furthermore, changing over from one part to the other on these machines also consumes
considerable time. The high cost and long time of these hard automated machines to produce
parts can be justified only in mass production. With the advent of fast, rigid and accurate
CNC machines and sophisticated CAM packages, generation of NC programs and change
over from one product to the other are easy and fast as it does not require any mechanical
change. These in conjunction with advanced cutting tools have made High Speed Cutting
(HSC) of hard materials a reality. Therefore, CNC machining has become a standard means
to produce dies and molds; tool makers today require EDM only for producing inaccessible
regions, sharp corners, tiny features and desired surface quality. Intricate aerospace parts are
realized through 5 axis CNC machining. Internet technology in a global village enables
designing in one place, NC programming and verification in another place and actual
machining in yet another place.
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G&M Codes are the generic name for a control language for CNC machines. It is a way for
you to tell the machine to move to various points at a desired speed , feed , control the spindle
speed , turn on and off various coolants, and all sorts of other things.

PREPARATORY FUNCTIONS

G code is Pre-set function associated with the movement of machine axes and associated
geometry.

List of G-codes:

Code Description Milling(M ) | Turning(T)
GO0 | Rapid positioning M T

GO01 | Linear interpolation M T

G02 | Circular interpolation, clockwise M T

GO03 | Circular interpolation, counterclockwise M T

G04 | Dwell M T

(138(?0% High-precision contour control (HPCC) M

8251 Al Advanced Preview Control M

G06.1 ' Non-uniform rational B-spline (NURBS) Machining M
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GO07 | Imaginary axis designation

G09 | Exact stop check, non-modal T

G10 | Programmable data input T

G11 | Data write cancel T

G12 | Full-circle interpolation, clockwise

G13 | Full-circle interpolation, counterclockwise

G17 | XY plane selection

G18 | ZX plane selection T

G19 | YZplane selection

G20 | Programming in inches T

G21  Programming in millimeters (mm) T

G28 | Returnto home position (machine zero, aka machine T
reference point)

G30 Retur_n to secondary h_ome position (machine zero, aka T
machine reference point)

G31 | Skip function (used for probes and tool length

measurement systems)
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G32 | Single-point threading, longhand style (if not using a cycle, n
e.g., G76)

G33 | Constant-pitch threading

G33 | Single-point threading, longhand style (if not using a cycle, T
e.g., G76)

G34 | Variable-pitch threading

G40 | Tool radius compensation off T

G41 | Tool radius compensation left T

G42 | Tool radius compensation right T

G43 | Tool height offset compensation negative

G44 | Tool height offset compensation positive

G45 | Axis offset single increase

G46 | Axis offset single decrease

G47 | Axis offset double increase

G48 | Axis offset double decrease

G49 | Tool length offset compensation cancel

G50 | Define the maximum spindle speed T

G50 | Scaling function cancel

G50 | Position register (programming of vector from part zero to
tool tip) T
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G52 | Local coordinate system (LCS) M
G53 | Machine coordinate system M T
G54 .
0 Work coordinate systems (WCSs) M T
G59
G61 | Exact stop check, modal M T
G62 | Automatic corner override M T
G64 | Default cutting mode (cancel exact stop check mode) M T
G68 | Rotate coordinate system. M
G69 | Turn off coordinate system rotation. M
G70 | Fixed cycle, multiple repetitive cycle, for finishing

(including contours) T
G71 | Fixed cycle, multiple repetitive cycle, for roughing (Z-axis T

emphasis)
G72 | Fixed cycle, multiple repetitive cycle, for roughing (X-axis

emphasis) T
G73 | Fixed cycle, multiple repetitive cycle, for roughing, with

pattern repetition T
G73 | Peck drilling cycle for milling — high-speed (NO full

retraction from pecks) M
G74 | Peck drilling cycle for turning T
G74 | Tapping cycle for milling, lefthand thread, M04 spindle

direction M
G75 | Peck grooving cycle for turning T
G76 | Fine boring cycle for milling M
G76 | Threading cycle for turning, multiple repetitive cycle T

[CAD/CAM MANUAL]


https://en.wikipedia.org/wiki/Screw_thread#Handedness
https://en.wikipedia.org/wiki/G-code#M04
https://en.wikipedia.org/wiki/G-code#M04

MREC (A) Mechanical
G80 | Cancel canned cycle T
G81 | Simple drilling cycle
G82 | Drilling cycle with dwell
G83 | Peck drilling cycle (full retraction from pecks)
G84 | Tapping cycle,righthand thread,M03 spindle direction
G85 | boring cycle, feed in/feed out
G86 | boring cycle, feed in/spindle stop/rapid out
G87 | boring cycle, backboring
G88 | boring cycle, feed in/spindle stop/manual operation
G89 | boring cycle, feed in/dwell/feed out
G90 | Absolute programming T (B)
G90 | Fixed cycle, simple cycle, for roughing (Z-axis emphasis) T(A)
Go1 Incremental programming T (B)
G92 | Position register (programming of vector from part zero to

. T (B)

tool tip)

G92 | Threading cycle, simple cycle T(A)
G94 | Feedrate per minute T (B)
G94 | Fixed cycle, simple cycle, for roughing (X-axis emphasis) T(A)
G95 | Feedrate per revolution T (B)
G96 | Constant surface speed (CSS) T
G97 | Constant spindle speed T

[CAD/CAM MANUAL]


https://en.wikipedia.org/wiki/Canned_cycle
https://en.wikipedia.org/wiki/Tap_and_die
https://en.wikipedia.org/wiki/Screw_thread#Handedness
https://en.wikipedia.org/wiki/G-code#M03
https://en.wikipedia.org/wiki/G-code#X

MREC (A) Mechanical

G98 | Return to initial Z level in canned cycle

G98 | Feedrate per minute (group type A) T (A)

G99 | Feedrate per revolution (group type A) T (A)

M code is actually operate some controls on the machine tool and thus affect the running of
the machine.

List of M-codes- MISCELLANEOUS FUNCTIONS

.. Milling Turning
Code Description
g (M) (T)
MO0 Compulsory stop M T
MO01 Optional stop M T
MO02 End of program M T
MO03 Spindle on (clockwise rotation) M T
MO04 Spindle on (counterclockwise rotation) T
MO05 Spindle stop M T
Niltle Automatic tool change (ATC) M T (some-
times)
MO07 Coolant on (mist) T
M08 Coolant on (flood) M T
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M09 Coolant off T
M10 Pallet clamp on

M11 Pallet clamp off

M13 Spindle on (clockwise rotation) and coolant on (flood)

M19 Spindle orientation T
M21 Mirror, X-axis

M21 Tailstock forward T
M22 Mirror, Y-axis

M22 Tailstock backward T
M23 Mirror OFF

M23 Thread gradual pullout ON T
M24 Thread gradual pullout OFF T
M30 End of program, with return to program top T
it Gear select — gear 1 T
M42 Gear select — gear 2 T
M43 Gear select — gear 3 T
M44 Gear select — gear 4 T
e Feedrate override allowed T
M49 Feedrate override NOT allowed T
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1112 Unload Last tool from spindle M !
M60 Automatic pallet change (APC) M

N Subprogram call M !
B Subprogram end M !
ADDRESSES -

N- refers to the block number.

G- refers to the G code (Preparatory function).

X- refers to the absolute/incremental distance travelled by the slide tool in the X axis
direction.

Y- refers to the absolute/incremental distance travelled by the slide tool in the Y axis
direction.

Z- refers to the absolute/incremental distance travelled by the slide tool in the Z axis
direction.

F -refers to the feed rate.

M -refers to the M code (Miscellaneous function).

S -refers to the spindle speed.

T- refers to the tooling management.

Introduction to CNC Milling

CNC LATHE

CNC lathes are rapidly replacing the older production lathes (multispindle, etc) due to
their ease of setting and operation. They are designed to use modern carbide tooling and fully
utilize modern processes. The part may be designed and the tool paths programmed by the
CAD/CAM process, and the resulting file uploaded to the machine, and once set and trailed
the machine will continue to turn out parts under the occasional supervision of an operator.
The machine is controlled electronically via a computer menu style interface; the program
may be modified and displayed at the machine, along with a simulated view of the process.
The setter/operator needs a high level of skill to perform the process, however the knowledge
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base is broader compared to the older production machines where intimate knowledge of
each machine was considered essential. These machines are often set and operated by the
same person, where the operator will supervise a small number of machines (cell).

CNC PROGRAMMING

The coordinates are almost exclusively Cartesian and the origin is on the work piece.
For a lathe, the in feed/radial axis is the x-axis, the carriage/length axis is the z-axis. There is
no need for a y-axis because the tool moves in a plane through the rotational center of the
work. Coordinates on the work piece shown below are relative to the work

Head Tail Stock

WARNING: Be cautious, the x

z T o 5
axds is mbwittvely the radins
6% 4@:- of the workpiers, But, marey
f

systerns 1se the dimension
' g a diameter, Ialke mure you

¥ know what the coordmate
walues are for.

CNC lathe / CNC XLTURN center

PROCEDURE FOR OPERATING CNC XL- Turn

Computer on

Wait for few minutes for display
Open CNC trainer software
Select file —new

Enter the program

Save the program(save as)-ok

YVVVVYVY

FOR SIMULATION->AUTO->RESET->CYCLE START

» Stabilizer on

» Control unit switch on

> Release emergency valve

» Go to menu bar->machine option—> machine link—>ok
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» Select ‘HOME?’, click on ‘x’, click on ‘z’>0k

» Select ‘RAPID’, move the tool towards work piece in z-ve direction and x-ve
direction to touch the work piece. Before touching the work piece with tool, Switch
the on the spindle manually by using MO3.

»  For slow movement of the tool, select ‘jog’ mode

»  Touch the work piece —select datum-click on ‘x’->specify billet diameter

» Move the tool in the ‘x’+ve direction and ‘ztve ‘ direction and touch the workpiece
at the face of the billet >select datum-> click on ‘ z> ok

» Now select ‘HOME’, click on X and Z->0k

FOR PROGRAM EXECUTION: AUTO>RESET->CYCLE START
Note:

To stop machine in between, press Emergency stop or ‘Reset’.

EXPT:7 STEP TURNING OPERATION

AIM: To write the manual part program for the given component as per given dimensions,
execute the same in CNC Lathe and manufacture the Component.

MATERIAL REQUIRED: Aluminum round bar of 30 mm diameter and 70 mm length.

PART DRAWING:
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All Dimensions are in mm

PARTPROGRAM:

[BILLET X30 Z60
G21 G98
G28 UOWO
MO06 TO1
MO03 S1000
G00 X3171
G90 X30 Z-40 F60
X29.5
X29
X28.5
X28
X27.5
X27
X26.5
X26
X25.5
X25
G90 X24.5 Z-30F60
X24
X23.5
X23
X22.5
X22
X21.5
X21
X20.5
X20
G90 X19.5 Z-20 F60
X19
X18.5
X18
X17.5
X17

Mechanical
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X16.5
X16
X15.5
X15
G90 X14.5 Z-10 F60
X14
X13.5
X13
X12.5
X12
X11.5
X11
X10.5
X10
G28 UOWO
MO05
M30;

PROCEDURE:

1. Write the Part Program using G codes and M codes for the component.

2. Using the Simulation Software FANUC run the part program and make corrections if any.
3. Place the workpiece in the Chuck and fix it with Chuck Key.

4. Set the tool home position.

5. Move the tool towards the work piece manually to specify the tool offset values.

6. Again Set the tool home position.

7. Execute the program to get the required shape of the work piece by Selecting
Auto 2 reset 2 cycle start.

8. Remove the finished work piece from the chuck.
RESULT:

The part program for the given component is written and the Component is machined
as per the dimensions.
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EXPT:8 MULTIPLE TURNING CYCLE

AIM: To write the manual part program for the given component as per given dimensions,
execute the same in CNC Lathe and manufacture the Component.

MATERIAL REQUIRED: Aluminum round bar of 30 mm diameter and 60 mm length..

PART DRAWING:

All Dimensions are in mm

PARTPROGRAM:

[BILLET X30 Z60

G21 G98

G28 U0 WO

MO06 TO1

MO03 S1200

G00 X32 71

G71 U0.25 RO.5

G71 P10 Q50 UO.1 WO0.1 F60
N10 GO0 X8 Z0

N20 GO1 X14 Z-15
N30 G03 X22 Z-23 R8
N40 G01 X22 Z-30
N50 G02 X30 Z-38 R8
G70 P10 Q50

G28 U0 WO

MO05

M30
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PROCEDURE:

1. Write the Part Program using G codes and M codes for the component.

2. Using the Simulation Software FANUC run the part program and make corrections if any.
3. Place the workpiece in the Chuck and fix it with Chuck Key.

4. Set the tool home position.

5. Move the tool towards the work piece manually to specify the tool offset values.

6. Again Set the tool home position.

7. Execute the program to get the required shape of the work piece by Selecting
Auto 2 reset 2 cycle start.

8. Remove the finished work piece from the chuck.
RESULT:

The part program for the given component is written and the Component is machined
as per the dimensions.
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EXPT: 9 THREADING CYCLE

AIM: To write the manual part program for the given component as per given dimensions,
execute the same in CNC Lathe and manufacture the Component.

MATERIAL REQUIRED: Aluminum round bar of 30 mm diameter and 60 mm length.

PART DRAWING:

All Dimensions are in mm

PARTPROGRAM:

[BILLET X30 Z60
G21 G98
G28 UOWO
MO06 TO1
MO03 S1000
G00 X3171
G90 X30 Z-40 F60
X29.5
X29
X28.5
X28
X27.5
X27
X26.5
X26
X25.5
X25
G90 X24.5 Z-30F60
X24
X23.5
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X23
X22.5
X22
X21.5
X21
X20.5
X20

G28 VOWO0

MO5

G21 G98

G28 UOWO

MO6T05

MO3 S1000

G00 X20 Z0

G76 P031560 Q60 R0.01
G76 X 18.774 Z-30 P613 Q60 F1
G28 UOWO

MO5

M30

PROCEDURE:

1.

2.

8.

Write the Part Program using G codes and M codes for the component.

Using the Simulation Software FANUC run the part program and make corrections if any.

. Place the workpiece in the Chuck and fix it with Chuck Key.

. Set the tool home position.

. Move the tool towards the work piece manually to specify the tool offset values.
. Again Set the tool home position.

. Execute the program to get the required shape of the work piece by Selecting

Auto > reset = cycle start.

Remove the finished work piece from the chuck.

RESULT:

The part program for the given component is written and the Component is machined

as per the dimensions.
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Introduction to CNC Milling

CNC milling is a specific form of computer numerical controlled (CNC) machining.
Milling itself is a machining process similar to both drilling and cutting, and able to achieve
many of the operations performed by cutting and drilling machines. Like drilling, milling uses
a rotating cylindrical cutting tool.

CNC MILLING COORDINAE SYSTEM:

Then Find Xand Y -

™ Machine table

—7 G
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PROCEDURE FOR OPERATING CNC XL-MILL MACHINE.

Main switch ON.
Controller ON.
Green switch ON.
Wait for few minutes for Display (Beep sound).
Release Emergency switch.(In clockwise)
Reset.
Select Home
Then Start
Now machine is ready

How to Write/Edit a Program

File—Local Disk (D)-----EOB------ Program Folder------ EOB

Edit New Enter folder name------ EOB(this saves the program with the given
folder name)

Now Select the saved program------ EOB

Press Reset while entering the program.

Edit(F1)----New(F1)----Name----EOB

In order to select the previous program (prog sec) (F2).

To Change Tool Manually

Go to Monitor----MDI-----Edit----M25---Start EOB (Hold tool)
To fix the tool M24----Start EOB

Tool Offsets

To move the axis always select JOG mode.

JOG:

X+ve,Y-ve,Z-ve,

2.

To Reduce the spindle feed go to Monitor ------ press 1

This reduces the feed rate.

3.

1.

Should touch the work piece by Z-ve,

For References
Select POS(position)---REL(Relative)----press X-ve----CANCEL,
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Select X+ve,for center setting,

For Decimal point adjustment go to MPG-----Press arrow for getting zero
Step Mode Press arrows for getting the decimal point to Zero.

Select POS-----REL-----Press Y-ve-----CANCEL,

Select Y+ve EOB.

Same as above.

For Saving all, the above go to

Co Ordinate----EDIT----G56----EDIT-----Press X+ve-----EOB

Press---Y+ve----EOB

Offset saved.
9. For Z, Press EXP(F2)------ Height Offset,

CO-Ordinate ----- EDIT----EXP----TOOL-OFFSET------ 5-----Press Z+ve-----EOB

Simulation
1. Select the program-----EDIT-----Select program(PGM SEC)----Reset(save)

2. Monitor----- Path----Middle.

N O~ wWD

Program execution
1. PROGRAM------ MONITOR----AUTO----RESET----START

2. To Stop in between Press RESET.
3. Again to continue the program START.
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EXPT: 10 DRILLING CYCLE

AIM: To write the manual part program for the given component as per given dimensions
and execute the same in CNC Mill.

MATERIAL REQUIRED: Aluminum Plate of 80mmx80mmx10mm

PART DRAWING:

4 HOLES
R4

T A p—

All Dimensions are in mm

PARTPROGRAM:
G21 GY%4

G28 G91 X0 YO0 Z0

MO06 TO1

MO03 S1500

GO0 G90 G54 X0 YO0

GO00 G43 H1 25

GO01 Z0 F200

G83 G98 X-20 Y-20 Z-10 Q2 R1F80
X-20' Y20
X20 Y20
X20Y-20

GO0 G90 G80 710

G28 G91 X0 YO0 Z0

MO05
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PROCEDURE:

1. Write the Part Program using G codes and M codes for the component.

2. Using the Simulation Software FANUC run the part program and make corrections if any.
3. Fix the workpiece on the worktable using Allen Keys.

4. Set the home position of the Machine.

5. Move the tool towards the work piece manually to specify the tool offset values.

()]

. Again set the home position of the Machine.

\l

. Execute the program to get the required shape of the work piece by Selecting
Auto 2 reset 2 cycle start.

8. Remove the finished work piece from the worktable.
RESULT:
The part program for the given workpiece is written and the Component is

Machined as per the given dimensions.
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EXPT: 11 CONTOUR CYCLE

AIM: To write the manual part program for the given component as per given dimensions
and execute the same in CNC Mill.

MATERIAL REQUIRED: Aluminum Plate of 80mmx80mmx10mm

PART DRAWING:

All Dimensionsare in mm

PARTPROGRAM:
0001:

BILLET 90mmx90mmx10mm
G21GY%

G91 G28 X0 Y0 Z0

MO06 T04

MO03 S1500

G00 G90 G54 X0 YO

G00 X-30 Y-30

G00 G43 H4 75

GO01 Z0 F200
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M98 P2 L10
G00 G90 Z10
G28G91 X0 Y0 Z0
MO05

M30

0002

GO1 G91 Z-0.5 F80
GO1 X30 Y-30
GO1 X30 Y20

G03 X20 Y30 R10
GO1 X-20 Y30
G02 X-30 Y20 R10
GO1 X-30 Y-30
M99
PROCEDURE:

1. Write the Part Program using G codes and M codes for the component.

N

w

. Fix the workpiece on the worktable using Allen Keys.

4. Set the home position of the Machine.

(6]

(o2}

\‘

. Again set the home position of the Machine.

8. Remove the finished work piece from the worktable.

RESULT:

. Using the Simulation Software FANUC run the part program and make corrections if any.

. Move the tool towards the work piece manually to specify the tool offset values.

. Execute the program to get the required shape of the work piece by Selecting
Auto - reset = cycle start.

The part program for the given workpiece is written and the Component is

Machined as per the given dimensions.
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EXPT: 12 POCKETING OPERATION

AIM: To write the manual part program for the given component as per given dimensions
and execute the same in CNC Mill.

MATERIAL REQUIRED: Aluminum Plate of 80mmx80mmx10mm

PART DRAWING:

All Dimensions are in mm

PARTPROGRAM:
0001:

BILLET 90mmx90mmx10mm
G21GY%

G91 G28 X0 Y0 Z0

MO06 TO1

MO03 S1500

G00 G90 G54 X0 YO

G00 X-30 Y-30

G00 G43 H1 75

GO01 Z0 F200

M98 P2 L10
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G00 G90 7210
G28G91 X0 YO0 Z0
MO5
M30
0002
G01 G91 Z-0.5 F80
GO01 G90 G42 D10 X-5 YO F500
Y5
X5
Y-5
YO0
G40
GO01 G90 G42 D10 X-10 Y0 F500
Y10
X10
Y-10
X-10
YO0
G40
G01 G90 G42 D10 X-15 YO F500

Y15
X15
Y-15
X-15
YO0
G40 GO0 X0 YO
M99
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PROCEDURE:

1. Write the Part Program using G codes and M codes for the component.

N

. Using the Simulation Software FANUC run the part program and make corrections if any.

w

. Fix the workpiece on the worktable using Allen Keys.

4. Set the home position of the Machine.

(621

. Move the tool towards the work piece manually to specify the tool offset values.

()]

. Again set the home position of the Machine.

\l

. Execute the program to get the required shape of the work piece by Selecting
Auto 2 reset 2 cycle start.

8. Remove the finished work piece from the worktable.
RESULT:
The part program for the given workpiece is written and the Component is

Machined as per the given dimensions.
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	Description of Extrusion Feature:
	❖ The first feature that is created.
	1. Select a sketch plane.
	1. Sketch a 2D profile of the model
	Procedure:
	Result:
	Ex: 2 Exercise on Revolve
	Description of Revolve Feature:
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